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À propos de ce manuel...
Le présent manuel contient des informations destinées à vous apprendre à 
utiliser le Logiciel pour le poste de travail Agilent MassHunter – Analyse 
qualitative  avec des données CPG/SM. 

Avant de commencer les exercices, lisez les instructions de la section « Avant 
de commencer ces exercices... » à la page 5.

Exercice 1 Apprendre les bases de l'analyse qualitative

Au cours de cet exercice, vous allez explorer certaines des nombreuses 
fonctionnalités performantes du programme d'analyse qualitative. Ces tâches 
sont importantes, quel que soit le type de données que vous utilisez.

Exercice 2 Détection et identification

Au cours de ces deux ensembles de tâches, vous recherchez et identifiez les 
basses concentrations en sulfamides au sein d’une matrice complexe et 
générez leurs formules pour les données TOF et Q-TOF. Vous effectuez 
également une d’extraction de motifs moléculaires de Protein Digest avec des 
données TOF et Q-TOF. Ces tâches peuvent également être effectuées avec des 
données Triple Quad.

Exercice 3 Utilisation des flux de travaux, exportation et impression

Au cours de ces tâches, vous allez apprendre comment configurer et exécuter 
toute méthode d’analyse qualitative. Vous apprendrez également à éditer une 
méthode d’automatisation de l’analyse et/ou une identification du composé. 
Vous exécuterez ensuite les actions dans la méthode automatisée lorsque vous 
ouvrirez un fichier de données. Vous apprendrez également à créer une 
méthode pour exécuter des actions automatisées avec une liste de tâches. 
Chacune de ces tâches est exécutée à l’aide d’un flux de travaux différent.

Référence

Dans ce chapitre, vous allez apprendre des principes de base du programme 
Qualitative Analysis.
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Nouveautés

de B.06.00

• Vous pouvez réviser des composés dans la fenêtre Compound Details View. 
Quatre fenêtres supplémentaires sont disponibles dans Compound Details 
View.

• Pour Compound Details View, vous pouvez définir différentes définitions 
de ligne pour différents types de chromatogrammes et spectres.

• L'algorithme Find Compounds by Integration est disponible.

• Vous pouvez rechercher dans plusieurs bibliothèques pour l'algorithme 
Unit Mass Library Search.

• Dans l'algorithme Generate Formulas, vous pouvez choisir d'annoter les 
pics de spectre fragment avec des formules. L'annotation fragment 
sélectionne des spectres pour annoter en fonction de l'algorithme d'analyse 
des composés.

• L'algorithme Generate Formulas peut être exécuté sur des composés 
détectés par l'algorithme Find by Chromatogram Deconvolution.

• L'algorithme Generate Formula a été modifié pour vous permettre d'entrer 
un nombre maximum d'éléments trouvés pour chaque vecteur de charge.

• Dans l'algorithme Generate Formulas, vous pouvez grouper les éléments 
trouvés avec la même formule, mais avec différents vecteurs de charge.

• Des composés peuvent être créés à partir d'un spectre utilisateur. Dans ce 
cas, l'algorithme d'analyse des composés est Spectrum Extraction.

• Lorsque vous enregistrez des résultats avec un fichier de données, vous 
pouvez choisir d'enregistrer tous les résultats des composés avec un fichier 
de données ou un ensemble plus petit de résultats pour chaque composé. 
Les chromatogrammes utilisateur et les spectres utilisateur sont toujours 
enregistrés.

• Le format du fichier CEF a été modifié de façon à ce que davantage 
d'informations soient incluses.

• Les informations relatives au m/z et à l'espèce de l'ion sont disponibles 
dans le premier niveau du tableau Spectrum Identification Results.

• Le tableau Spectrum Identification a été modifié. Vous pouvez ajouter un 
filtre à une colonne et vous pouvez supprimer une ligne.

• Vous pouvez désormais libeller un pic avec Formula & Ion Species.
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• Le changement du spectre libellé Best dans la fenêtre Spectrum 
Identification Results lorsque vous disposez d'un grand nombre d'entrées 
est désormais considérablement plus rapide.

• Vous pouvez spécifier le chevauchement des chromatogrammes de 
composés dans Compound Report.

• Le modèle de rapport par défaut Formula Confirmation a été modifié pour 
inclure la colonne colorée Flags (Tgt) et le tableau Fragment comporte la 
colonne colorée Flags (FIs).

Avant de commencer ces exercices...
• Installez le logiciel. Pour les instructions, reportez-vous au Guide 

d'installation.

• Copiez le dossier nommé Data du disque d'installation au format non 
compressé à l'emplacement de votre choix sur votre disque dur. 

Ce dossier contient tous les fichiers de données requis pour ces exercices. 
Il se peut que vous deviez extraire au préalable les fichiers de données de 
leur format .zip.

REMARQUE Ne réutilisez pas les fichiers de données exemples déjà présents sur votre système, à 
moins d'être sûr de les avoir copiés à partir des fichiers originaux du disque et que vous 
êtes la seule personne à les utiliser. Si les fichiers de données exemples déjà présents sur 
le système ne correspondent pas exactement aux originaux présents sur le disque, les 
résultats obtenus pendant les exercices ne correspondront pas aux illustrations de ce 
manuel.
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Logiciel pour le poste de travail Agilent MassHunter Analyse qualitative
Guide de familiarisation
1
Apprendre les bases de l'analyse 
qualitative

Tâche 1. Ouverture du programme d'analyse qualitative 10

Tâche 2. Configuration de l'interface utilisateur pour des données 
CPG/SM 13

Tâche 3. Zoom avant et arrière sur le chromatogramme 16

Tâche 4. Ancrage d'un chromatogramme 17

Tâche 5. Changement de disposition des fenêtres 19

Tâche 6. Extraction de chromatogrammes 21

Tâche 7. Intégration interactive d'un chromatogramme CPG/SM 23

Tâche 8. Calculez les valeurs d'adéquation du système (System 
Suitability) 28

Tâche 9. Extraction de spectres d'un chromatogramme 32

Tâche 10. Ajout d'annotations 42

Tâche 11. Ajout d'un compas d'épaisseur de masse 46

Au cours de cet exercice, vous allez explorer certaines des nombreuses 
fonctionnalités performantes du programme d'analyse qualitative pour 
travailler avec des données de CPG/Q-TOF et CPG/QQQ.

Chaque exercice est présenté dans un tableau à trois colonnes:

• Étapes: utilisez ces instructions générales afin d'explorer le programme par 
vous-même.

• Instructions détaillées: utilisez-les si vous avez besoin d'aide ou si vous 
préférez suivre une méthode d'apprentissage pas à pas.

• Remarques: lisez-les pour obtenir des astuces et des informations 
supplémentaires sur chaque étape de l'exercice.
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1 Apprendre les bases de l'analyse qualitative
Tâche 1. Ouverture du programme d'analyse qualitative
Tâche 1. Ouverture du programme d'analyse qualitative

Au cours de cette tâche, vous allez ouvrir plusieurs fichiers de données à l'aide 
de la méthode habituelle. 

 

Tâche 1. Ouverture du programme d'analyse qualitative avec plusieurs fichiers de données

Étapes Instructions détaillées Remarques

1 Ouvrir le programme d'analyse 
qualitative. 
• Ouvrez les fichiers de données 

Pest - 200 - Scan.d, Pest - STD 
200 MRM.d, Pest Strawb-01 
SPIKED 1 ppb - 1 ul inj.d et 
MSD_mix_4stds_DG_spl200_0
3.d dans le dossier 
\\MassHunter\Data, ou dans 
le dossier dans lequel vous les 
avez copiés.

a Double-cliquez sur l'icône Agilent 
MassHunter Qualitative Analysis 
B.06.00 . 
Le système ouvre la boîte de dialogue 
Open Data Files.

b Accédez au dossier \\MassHunter\
Data\GC ou au dossier dans lequel se 
trouvent les fichiers d'exemples.

• Le fichier Pest - 200 - Scan.d 
contient des données SM, tandis 
que les fichiers Pest - STD 200 
MRM.d et Pest Strawb-01 SPIKED 1 
ppb - 1 ul inj.d contiennent des 
données SM et SM/SM 
(CPG/QQQ). Le fichier 
MSD_mix_4stds_DG_spl200_03.d 
contient des données CPG/Q-TOF.

• Vous pouvez obtenir de l'aide sur la 
plupart des fenêtres, boîtes de 
dialogue et onglets en appuyant sur 
la touche F1 lorsque la fenêtre est 
active.

• Assurez-vous que le bouton Use 
current method est sélectionné.

• Vérifiez que la case Load result 
data n'est pas cochée. Si cette 
case n'est pas disponible, cela 
signifie qu'aucun résultat n'a été 
enregistré dans le fichier de 
données. Pour savoir comment 
enregistrer des résultats, 
reportez-vous aux instructions 
de la « Tâche 17. Enregistrement 
des résultats », page 72.

• Vérifiez que la case Run ‘File 
Open’ actions from selected 
method n'est pas cochée.

Figure 1 Ouvrir des fichiers de données lors de l'ouverture du logiciel
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Apprendre les bases de l'analyse qualitative 1
Tâche 1. Ouverture du programme d'analyse qualitative
c Appuyez sur la touche Maj et 
maintenez-la enfoncée pendant que 
vous cliquez sur Pest - 200 - Scan.d, 
Pest - STD 200 MRM.d, Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d et 
MSD_mix_4stds_DB_spl200_03.d.

d Cliquez sur Open.
Les quatre fichiers de données 
apparaissent dans la fenêtre Data 
Navigator, et 1 à 3chromatogrammes 
sont affichés dans la fenêtre 
Chromatogram Results.

e Cliquez sur l'icône List Mode  
dans la barre d'outils Chromatogram 
Results.

• Si vous appuyez sur la touche Ctrl, 
vous pouvez sélectionner des 
fichiers qui ne figurent pas 
directement l'un derrière l'autre 
dans la liste.

• Ce que vous pouvez voir dans la 
fenêtre principale à ce stade dépend 
de la méthode, de l'agencement, de 
l'affichage et des paramètres de 
tracé utilisés avant que vous 
n'ouvriez ces fichiers.

• Lorsque vous cliquez sur l'icône List 
Mode, la couleur de son fond 
change et devient orange.

Tâche 1. Ouverture du programme d'analyse qualitative avec plusieurs fichiers de données (suite)

Étapes Instructions détaillées Remarques
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1 Apprendre les bases de l'analyse qualitative
Tâche 1. Ouverture du programme d'analyse qualitative
Figure 2 Fenêtre principale de l'analyse qualitative avec l'écran GC/Q-TOF Compound Screening Workflow 
chargé. 

Tâche 1. Ouverture du programme d'analyse qualitative avec plusieurs fichiers de données (suite)

Étapes Instructions détaillées Remarques

icône Maximum 
Number of List 
Panes indiquant le 
nombre maximum 
de volets liste

icône Display Options 
(Options d'affichage)

Pour fermer la fenêtre, 
cliquez sur le bouton X.
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Apprendre les bases de l'analyse qualitative 1
Tâche 2. Configuration de l'interface utilisateur pour des données CPG/SM
Tâche 2. Configuration de l'interface utilisateur pour des données 
CPG/SM

Dans cette tâche, vous passez au flux de travaux général (pour les clients 
CPG/QQQ) ou au flux de travaux de criblage des composés CPG/Q-TOF (pour 
les clients CPG/Q-TOF). Ces deux flux de travaux sont les seuls qui prennent 
en charge l'analyse des données CPG/SM. Ensuite, ouvrez la boîte de dialogue 
User Interface Configuration et cochez les cases appropriées pour un système 
CPG/QQQ ou CPG/Q-TOF.

Tâche 2. Configuration de l'interface utilisateur pour des données CPG

Étapes Instructions détaillées Remarques

1 Si nécessaire, ouvrir le programme 
d'analyse qualitative. 

a Double-cliquez sur l'icône Agilent 
MassHunter Qualitative Analysis 

. 
Le système ouvre la boîte de dialogue 
Open Data Files.

b Cliquez sur Cancel dans la boîte de 
dialogue Open Data Files.

• Vous pouvez obtenir de l'aide sur 
n'importe quelle fenêtre, boîte de 
dialogue ou onglet en appuyant sur 
la touche F1 lorsque la fenêtre est 
active.

2 Passer au flux de travaux général 
ou au flux de travaux de criblage 
des composés CPG/Q-TOF.

a Si vous disposez d'un instrument 
CPG/QQQ, cliquez sur l'option 
Configuration > Configure for 
Workflow > General. Si vous disposez 
d'un instrument CPG/Q-TOF, cliquez 
sur l'option Configuration > Configure 
for Workflow > GC/Q-TOF Compound 
Screening.

b Cliquez sur le bouton Load workflow’s 
default method et le bouton Load 
workflow’s default layout.

c Cliquez sur OK.
d Cliquez sur l'icône List Mode  

dans la barre d'outils Chromatogram 
Results.

• Si le programme d'acquisition des 
données pour CPG/QQQ ou 
CPG/Q-TOF est installé sur le même 
ordinateur, le logiciel configure 
automatiquement l'interface 
utilisateur. La section GC/Q-TOF 
Compound Screening peut être déjà 
disponible dans la fenêtre Method 
Explorer.

• Par défaut, les chromatogrammes 
sont superposés. Pour ces 
exemples, les chromatogrammes 
sont affichés en Mode liste.
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1 Apprendre les bases de l'analyse qualitative
Tâche 2. Configuration de l'interface utilisateur pour des données CPG/SM
3 Si vous disposez d'un CPG/QQQ, 
configurez l'interface utilisateur 
afin que seules les fonctions 
CPG/QQQ s'affichent.

a Cliquez sur Configuration > User 
Interface Configuration.

b Sous Separation types, cochez 
uniquement la case GC.

c Si vous disposez d'un instrument 
CPG/QQQ, sous Ionization type, 
cochez la case EI or other “hard” 
ionization technique et 
désélectionnez la case CI, APCI, ESI, 
MADLDI or other “soft” ionization 
technique.

d Sous Mass accuracy, désélectionnez 
la case Accurate mass (TOF, Q-TOF). 
Cochez la case Unit mass (Q, QQQ).

e Sous Optional software features, 
désélectionnez les cases Peptide 
Sequence Editor et BioConfirm 
Software.

f Sous Non-MS detectors, 
désélectionnez les cases UV et ADC.

g Cochez la case Show advanced 
parameters.

h Cliquez sur OK.

• La boîte de dialogue User Interface 
Configuration permet de changer 
les options disponibles. 

• Si une fonction n'est pas visible, 
elle était probablement masquée 
lorsqu'une case a été 
désélectionnée dans la boîte de 
dialogue User Interface 
Configuration.

Figure 3 Configuration de l'interface utilisateur à utiliser avec des données CPG/QQQ

Tâche 2. Configuration de l'interface utilisateur pour des données CPG

Étapes Instructions détaillées Remarques
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Apprendre les bases de l'analyse qualitative 1
Tâche 2. Configuration de l'interface utilisateur pour des données CPG/SM
4 Si vous disposez d'un CPG/Q-TOF, 
configurez l'interface utilisateur 
afin que seules les fonctions 
CPG/Q-TOF s'affichent.

a Cliquez sur Configuration > User 
Interface Configuration.

b Sous Separation types, cochez 
uniquement la case GC.

c Sous Ionization type, cochez les deux 
cases.

d Sous MS levels, cochez les deux 
cases.

e Sous Mass accuracy, cochez la case 
Accurate mass (TOF, Q-TOF). 
Désélectionnez la case Unit mass 
(Q, QQQ).

f Sous Optional software features, 
désélectionnez les cases Peptide 
Sequence Editor et BioConfirm 
Software.

g Sous Non-MS detectors, 
désélectionnez les cases UV et ADC.

h Cochez la case Show advanced 
parameters.

i Cliquez sur OK.

• La boîte de dialogue User Interface 
Configuration permet de changer 
les options disponibles. 

• Si une fonction n'est pas visible, 
elle était probablement masquée 
lorsqu'une case a été 
désélectionnée dans la boîte de 
dialogue User Interface 
Configuration.

Figure 4 Configuration de l'interface utilisateur pour un CPG/Q-TOF

Tâche 2. Configuration de l'interface utilisateur pour des données CPG

Étapes Instructions détaillées Remarques
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1 Apprendre les bases de l'analyse qualitative
Tâche 3. Zoom avant et arrière sur le chromatogramme
Tâche 3. Zoom avant et arrière sur le chromatogramme

Cette tâche vous permet de vous familiariser avec les fonctions de zoom avant 
et arrière du programme d'analyse qualitative.
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Apprendre les bases de l'analyse qualitative 1
Tâche 4. Ancrage d'un chromatogramme
Tâche 4. Ancrage d'un chromatogramme

Au cours de cette tâche, vous allez ancrer un chromatogramme. Si vous ancrez 
un chromatogramme, le chromatogramme ancré reste affiché en permanence 
pendant que vous faites défiler les autres chromatogrammes pour les afficher.

Tâche 4. Ancrage d'un chromatogramme

Étapes Instructions détaillées Remarques

• Ancrer un chromatogramme.
• Afficher tous les 

chromatogrammes.
• S'assurer que la liste d'affichage 

des chromatogrammes est 
définie à 1.

• Dans la fenêtre Chromatogram 
Results, sélectionnez le 
deuxième chromatogramme de 
courant ionique total (CIT).

• Ancrer ce CIT.
• Faire défiler les 

chromatogrammes.
• Supprimer l'ancrage.

a Dans la fenêtre Data Navigator, cochez 
les cases correspondant aux 
chromatogrammes que vous avez 
masqués au cours de la précédente 
tâche.

b Assurez-vous que le nombre maximal 
de volets est défini à 1 dans la fenêtre 
Chromatogram Results.

c Dans la fenêtre Chromatogram 
Results, sélectionnez le deuxième 
chromatogramme de courant ionique 
total (CIT).

d Cliquez avec le bouton droit de la 
souris sur le chromatogramme, puis 
cliquez sur Set Anchor.

e Utilisez la barre de défilement dans la 
fenêtre Chromatogram Results pour 
faire défiler la liste de 
chromatogrammes. Le deuxième CIT 
reste toujours visible comme le 
premier chromatogramme. 

f Cliquez sur Chromatograms > Clear 
Anchor.

• Lorsque vous définissez un ancrage 
pour un chromatogramme, une 
icône représentant une ancre 
apparaît dans la fenêtre Data 
Navigator, en regard du nom du 
chromatogramme ancré.

• Deux chromatogrammes 
apparaissent dans la fenêtre 
Chromatogram Results après que 
l'un d'eux ait été ancré bien que la 
liste d'affichage soit définie à 1. 
Ceci signifie que vous affichez un 
chromatogramme en plus du 
chromatogramme ancré.

• Vous pouvez également cliquer 
avec le bouton droit de la souris sur 
le chromatogramme, puis cliquer 
sur Clear Anchor dans le menu 
contextuel.
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1 Apprendre les bases de l'analyse qualitative
Tâche 4. Ancrage d'un chromatogramme
Figure 5 CIT ancré dans la fenêtre Chromatogram Results

Tâche 4. Ancrage d'un chromatogramme (suite)

Étapes Instructions détaillées Remarques
18 Logiciel pour le poste de travail Agilent MassHunter – Analyse qualitative – Guide de familiarisation pour CPL/SM



Apprendre les bases de l'analyse qualitative 1
Tâche 5. Changement de disposition des fenêtres
Tâche 5. Changement de disposition des fenêtres

Au cours de cette tâche, vous allez déplacer des fenêtres dans la vue principale 
et créer diverses présentations des fenêtres.

Tâche 5. Changement de disposition des fenêtres

Étapes Instructions détaillées Remarques

1 Changer la disposition des 
fenêtres:
• Changer la taille des fenêtres.
• Enregistrer une disposition de 

fenêtres.
• Déverrouiller la disposition.
• Changer la fenêtre 

Chromatogram Results afin 
qu'elle devienne flottante.

• Déplacer la fenêtre 
Chromatogram Results.

• Afficher les outils pour 
repositionner les fenêtres.

• Pour changer la taille d'une fenêtre, 
faites glisser la limite entre les 
fenêtres.

• Pour enregistrer une disposition de 
fenêtres, cliquez sur Configuration > 
Window Layouts > Save Layout.

• Pour déverrouiller une disposition, 
cliquez sur Configuration > Window 
Layouts > Lock Layout. 

• Pour rendre une fenêtre flottante, 
cliquez avec le bouton droit de la souris 
sur la barre de titre de la fenêtre et 
cliquez sur l'option Floating dans le 
menu contextuel.

• Pour déplacer une fenêtre, cliquez sur 
la barre de titre de la fenêtre et faites-la 
glisser à l'emplacement souhaité. 

• Pour afficher les outils de 
repositionnement, faites glisser la 
fenêtre sur l'une des autres fenêtres. 
Lorsque qu'une fenêtre est 
chevauchée par une autre, le 
programme affiche plusieurs outils de 
mise en page, comme illustré à la 
Figure 6.

• Si la disposition est déverrouillée, le 
système n'affiche pas de marque en 
regard du menu Lock Layout.

• Vous ne pouvez utiliser les outils de 
repositionnement que si la 
disposition est déverrouillée.

• Vous pouvez également rendre une 
fenêtre flottante en double-cliquant 
sur la barre de titre de la fenêtre.

• Plusieurs présentations différentes 
sont déjà créées dans le logiciel. 
Vous pouvez également essayer de 
les charger.

• Le logiciel comporte plusieurs flux 
de travaux différents. Chaque flux 
de travaux charge une présentation 
différente. Le fait de passer à un 
autre flux de travaux change 
également la présentation.
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Tâche 5. Changement de disposition des fenêtres
Figure 6 Outils de repositionnement des fenêtres

2 Repositionner la fenêtre 
Chromatogram Results.
• Déplacer la fenêtre afin qu'elle 

se trouve au-dessus, à gauche, à 
droite, puis en dessous des 
autres fenêtres.

• Déplacer deux fenêtres 
ensemble afin qu'elles se 
trouvent au-dessus d'une autre 
et disponibles uniquement par 
l'intermédiaire des onglets 
situés en bas. 

• Restaurer la disposition par 
défaut.

• Si vous passez le curseur sur l'une des 
petites icônes, la fenêtre que vous 
faites glisser sera placée au-dessus, à 
droite, en dessous ou à gauche de 
toutes les autres fenêtres. 

• Faites glisser le curseur sur la grande 
icône. La fenêtre peut être également 
placée au-dessus, à droite, en dessous 
ou à gauche de l'autre fenêtre en 
faisant glisser le curseur sur les côtés 
de la grande icône.

• Pour épingler deux fenêtres ensemble, 
faites glisser le curseur au centre de la 
grande icône. Vous verrez une version 
ombrée des deux fenêtres épinglées 
ensemble. Cessez de faire glisser la 
souris. Les deux fenêtres sont 
épinglées ensemble.

• Cliquez sur Configuration > Window 
Layouts > Restore Default Layout.

• Le curseur doit se trouver sur l'une 
des flèches dans une boîte pour que 
le repositionnement ait lieu.

• Le fait de cliquer sur Restore 
Default Layout restaure la 
présentation utilisée dans le flux de 
travaux général et celui de criblage 
des composés CPG/Q-TOF. Si vous 
utilisez un autre flux de travaux, 
vous devez charger la disposition 
utilisée avec celui-ci.

Tâche 5. Changement de disposition des fenêtres (suite)

Étapes Instructions détaillées Remarques
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Tâche 6. Extraction de chromatogrammes
Tâche 6. Extraction de chromatogrammes

Au cours de cette tâche, vous allez extraite et fusionner des chromatogrammes 
du CIT d'origine. 

Tâche 6. Extraction de chromatogrammes

Étapes Instructions détaillées Remarques

1 Extraire et faire fusionner des 
chromatogrammes d'ions extraits 
(CIE) de deux masses dans le 
fichier de données Pest - 200 
Scan.d.
• Les valeurs m/z sont 129.0 et 

414.2.
• Ne pas fusionner les pics de 

masses individuelles dans un 
chromatogramme.

a Dans la fenêtre Data Navigator, 
désélectionnez les cases à cocher des 
fichiers de données, excepté le fichier 
Pest - 200 Scan.d.

b Ouvrez la boîte de dialogue Extract 
Chromatograms, à l'aide de l'option 
ci-dessous ou de l'une des options de 
droite: 
• Cliquez sur Chromatograms > 

Extract Chromatograms.
c Dans la boîte List of opened data files, 

cliquez sur Pest - 200 - Scan.d.
d Dans la zone de liste Type, 

sélectionnez EIC.
e Dans le champ m/z value(s), 

saisissez 129.0, 414.2
f Le cas échéant, désélectionnez la case 

Merge multiple masses into one 
chromatogram pour fusionner les CIE.

g Cliquez sur OK.
h Définissez le nombre maximum de 

volets liste à 3 dans la barre d'outils 
Chromatogram Results.

• Vous pouvez également extraire des 
chromatogrammes de l'une des 
manières suivantes:
• Cliquez avec le bouton droit de la 

souris sur le chromatogramme, 
puis cliquez sur Extract 
Chromatograms.

• Dans Data Navigator, 
sélectionnez TIC Scan pour 
sulfas_PosMS.d, puis cliquez 
avec le bouton droit de la souris 
sur TIC Scan et cliquez sur 
Extract Chromatograms.

• Vous pouvez utiliser la valeur All ou 
MS pour MS level.

• Notez que vous pouvez également 
choisir que le chromatogramme 
extrait soit automatiquement 
intégré après l'extraction.

• Vous pouvez également extraire un 
chromatogramme d'un spectre de 
masse.
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Tâche 6. Extraction de chromatogrammes
Figure 7 Boîte de dialogue Extract Chromatograms

Figure 8 Chromatogrammes d'ions extraits (CIE) fusionnés comparés 
au CIT d'origine

Tâche 6. Extraction de chromatogrammes (suite)

Étapes Instructions détaillées Remarques
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Tâche 7. Intégration interactive d'un chromatogramme CPG/SM
Tâche 7. Intégration interactive d'un chromatogramme CPG/SM

Au cours de cette tâche, vous allez apprendre différentes façons d'intégrer un 
chromatogramme, de changer les paramètres d'intégration pour modifier les 
résultats et calculer le rapport signal/bruit pour les pics intégrés de données 
SM/SM.

Tâche 7. Intégration interactive d'un chromatogramme (CPG/SM)

Étapes Instructions détaillées Remarques

1 Intégrer le chromatogramme TIC 
Scan pour le fichier de données 
Pest - 200 - Scan.d, à l'aide de 
n'importe laquelle des options 
indiquées à droite.

a Sélectionnez le fichier de données 
Pest - 200 - Scan.D dans la fenêtre 
Data Navigator.

b Sélectionnez le chromatogramme TIC 
Scan et utilisez l'une des options 
suivantes:
• Dans la barre de menus, cliquez sur 

Chromatograms > Integrate 
Chromatogram.

• Cliquez avec le bouton droit de la 
souris n'importe où dans la fenêtre 
du chromatogramme, puis cliquez 
sur Integrate Chromatogram.

• Dans la fenêtre Data Navigator, 
sélectionnez Pest - 200 - Scan.D > 
User Chromatograms > TIC Scan, 
puis cliquez avec le bouton droit de 
la souris sur TIC Scan et cliquez sur 
Integrate Chromatogram.

• Notez que le programme a 
pratiquement intégré tous les pics 
dans le chromatogramme.

• Utilisez la fenêtre Method Editor 
pour sélectionner l'intégrateur à 
utiliser pour les données SM, les 
données SM/SM et les données 
CPG.

• Ce chromatogramme est un 
chromatogramme SM, les valeurs 
définies dans la section Integrate 
(MS) de la fenêtre Method Editor 
sont donc utilisées lors de 
l'intégration de ce 
chromatogramme.

2 Afficher uniquement deux 
chromatogrammes à la fois.

• Sélectionnez 2 comme nombre 
maximum de volets liste dans la barre 
d'outils Chromatogram Results.
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Tâche 7. Intégration interactive d'un chromatogramme CPG/SM
Figure 9 Chromatogramme TIC Scan intégré avec de nombreux petits pics

3 Changer le seuil pour intégrer 
moins de pics.
• Changer le seuil pour ne garder 

que les trois plus grands pics.

a Dans la fenêtre Method Explorer, 
cliquez sur Chromatogram > 
Integrate (MS) pour afficher l'onglet 
Integrate (MS).

b Sélectionnez l'intégrateur Agile.
c Cliquez sur l'onglet Peak Filters.
d Sous Maximum number of peaks, 

cochez Limit (by height) to the 
largest, et tapez 3.

• Notez le triangle bleu qui s'affiche 
lorsque vous changez la valeur d'un 
paramètre sauvegardée dans la 
méthode en cours. Lorsque vous 
enregistrez la méthode, les triangles 
disparaissent.

Figure 10 Onglet Peak Filters avec la case Limit (by height) to the 
largest cochée

Tâche 7. Intégration interactive d'un chromatogramme (CPG/SM) (suite)

Étapes Instructions détaillées Remarques

De nombreux petits pics sont 
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Tâche 7. Intégration interactive d'un chromatogramme CPG/SM
4 Réintégrer le chromatogramme. e Cliquez sur le bouton  dans la 
barre d'outils Method Editor pour 
effectuer l'intégration avec le nouveau 
paramètre.

• Notez que seuls les trois plus 
grands pics sont désormais 
intégrés.

• Le pic 2,491 est plus haut que celui 
enregistré à 16,858minutes, il est 
donc sélectionné comme troisième 
pic.

Figure 11 Chromatogramme TIC Scan intégré lors de la réduction du nombre de pics

5 Intégrer le chromatogramme TIC 
MRM pour le fichier de données 
Pest - STD 200 MRM.D.

a Dans la fenêtre Data Navigator, 
sélectionnez TIC MRM pour le fichier 
de données Pest - STD 200 MRM.d. 

b Utilisez l'une des options suivantes 
pour intégrer les chromatogrammes.
• Dans la barre de menus, cliquez sur 

Chromatograms > Integrate 
Chromatogram.

• Cliquez avec le bouton droit de la 
souris n'importe où dans la fenêtre 
du chromatogramme, puis cliquez 
sur Integrate Chromatogram.

• Dans la fenêtre Data Navigator, 
cliquez avec le bouton droit de la 
souris sur le chromatogramme en 
surbrillance et cliquez sur Integrate 
Chromatogram.

c Effectuez un zoom avant de 5,8 à 8,5 
minutes.

d Définissez le nombre maximum de 
volets liste à 2.

• Appuyez sur la touche Ctrl pour 
sélectionner plusieurs 
chromatogrammes dans la fenêtre 
Data Navigator.

• Notez que le programme a 
pratiquement intégré tous les pics 
dans le chromatogramme.

• Ces chromatogrammes sont des 
chromatogrammes SM/SM, les 
valeurs définies dans la section 
Integrate (MS/MS) de la fenêtre 
Method Editor sont donc utilisées 
lors de l'intégration de ce 
chromatogramme. Vous pouvez 
sélectionner l'intégrateur à utiliser 
pour intégrer des 
chromatogrammes SM et un autre 
intégrateur pour les 
chromatogrammes SM/SM.

Tâche 7. Intégration interactive d'un chromatogramme (CPG/SM) (suite)

Étapes Instructions détaillées Remarques
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Tâche 7. Intégration interactive d'un chromatogramme CPG/SM
Figure 12 Chromatogrammes MRM intégrés 

6 Sélectionnez l'intégrateur MS/MS 
(GC). Changer le filtre pour 
n'accepter que les pics ayant une 
hauteur absolue égale ou 
supérieure à 20000.

a Dans la fenêtre Method Explorer, 
sélectionnez Chromatogram > 
Integrate (MS/MS).

b Sélectionnez MS/MS (GC) comme 
intégrateur.

c Cliquez sur l'onglet Peak Filters.
d Sous Filter on, cliquez sur Peak 

height.
e Sous Height filters, cochez la case 

Absolute height.
f Tapez 60000 comme valeur de 

Absolute height.

• Notez le triangle bleu qui s'affiche 
lorsque vous changez la valeur d'un 
paramètre sauvegardée dans la 
méthode en cours. Lorsque vous 
enregistrez la méthode, les triangles 
disparaissent.

Figure 13 Onglet Peak Filters avec case Absolute height cochée

Tâche 7. Intégration interactive d'un chromatogramme (CPG/SM) (suite)

Étapes Instructions détaillées Remarques
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Tâche 7. Intégration interactive d'un chromatogramme CPG/SM
7 Réintégrer le chromatogramme. g Cliquez sur le bouton  dans la 
barre d'outils Method Editor.

• Notez que seuls les plus grands 
pics sont désormais intégrés.

Figure 14 Chromatogrammes CIT et CIE SM/SM intégrés avec un paramètre de seuil plus élevé

8 Restaurer les paramètres 
sauvegardés pour la méthode en 
cours et fermer la fenêtre Method 
Editor.

a Sélectionnez la section Chromatogram 
> Integrate (MS/MS) dans Method 
Explorer.

b Cliquez sur l'icône  dans Method 
Editor.

c Sélectionnez la section 
Chromatogram  > Integrate (MS) dans 
Method Explorer.

d Cliquez sur l'icône  dans Method 
Editor.

e Fermez la fenêtre Method Editor.

• Pour annuler vos modifications et 
restaurer les valeurs de la méthode 
chargée, cliquez sur l'icône 
Restaurer les dernières valeurs 
enregistrées du fichier  dans la 
barre d'outils Method Editor. 

9 Supprimer tous les 
chromatogrammes, excepté celui 
d'origine. Supprimer les résultats 
d'intégration du chromatogramme 
d'origine.

a Sous User Chromatograms dans la 
fenêtre Data Navigator, sélectionnez 
tous les chromatogrammes, excepté 
celui d'origine.

b Cliquez avec le bouton droit de la 
souris sur les chromatogrammes 
sélectionnés et cliquez sur Delete.

c Sélectionnez tous les 
chromatogrammes CIT.

d Cliquez sur Chromatograms > Clear 
Results.

• Si vous utilisez l'option Clear 
Results, les chromatogrammes ne 
sont pas supprimés; mais les 
résultats liés aux 
chromatogrammes le sont. Dans ce 
cas, les valeurs d'intégration sont 
effacées.

Tâche 7. Intégration interactive d'un chromatogramme (CPG/SM) (suite)

Étapes Instructions détaillées Remarques

Le petit pic situé à 5,8min n'est plus 
inclus dans les résultats d'intégration, 
car la hauteur absolue de ce pic est 
inférieure à 60000points.
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Tâche 8. Calculez les valeurs d'adéquation du système (System Suitability)
Tâche 8. Calculez les valeurs d'adéquation du système (System 
Suitability)

Au cours de cette tâche, vous allez apprendre différentes façons d'intégrer de 
manière interactive un chromatogramme, de changer les paramètres 
d'intégration pour modifier les résultats et d'afficher le rapport signal/bruit 
pour chaque pic. Vous apprendrez également comment activer les calculs 
d'adéquation du système.

Tâche 8. Intégration interactive d'un chromatogramme (SM)

Étapes Instructions détaillées Remarques

1 Intégrer les chromatogrammes 
MSD_mix_4stds_DB_spl200_03.d 
et Pest - 200 - Scan.d à l'aide de 
l'une des options indiquées à 
droite.

a Cochez la case en regard du fichier de 
données 
MSD_mix_4stds_DB_spl200_03.d 
dans la fenêtre Data Navigator.

b Cochez la case en regard du fichier de 
données Pest - 200 - Scan.d dans la 
fenêtre Data Navigator.

c Sélectionnez les deux CIT.
d Intégrez le TIC Scan pour ces deux 

fichiers, à l'aide de l'une des options 
suivantes.
• Dans le menu principal, cliquez sur 

Chromatograms > Integrate 
Chromatogram.

• Sélectionnez le chromatogramme. 
Ensuite, cliquez avec le bouton droit 
de la souris sur le chromatogramme, 
puis cliquez sur Integrate 
Chromatogram.

• Dans Data Navigator, sélectionnez 
TIC Scan pour les deux fichiers de 
données. Ensuite, cliquez avec le 
bouton droit de la souris sur l'un des 
chromatogrammes, puis cliquez sur 
Integrate Chromatogram.

• Pour le flux de travaux général, 
l'intégration utilise l'intégrateur 
General, car il s'agit de l'intégrateur 
sélectionné dans la méthode 
default.m. Pour le flux de travaux de 
criblage des composés CPC/Q-TOF, 
l'intégration utilise l'intégrateur 
Agile. 

• Vous pouvez changer cette valeur 
dans l'onglet Chromatogram > 
Integrate (MS) > Integrator.

• Notez que l'intégration avec les 
paramètres par défaut détecte des 
pics très petits.
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Tâche 8. Calculez les valeurs d'adéquation du système (System Suitability)
Figure 15 L'un des menus contextuels dans Data Navigator et les chromatogrammes intégrés

2 Activer les calculs d'adéquation du 
système pour les 
chromatogrammes SM.

a Dans la fenêtre Method Explorer, 
sélectionnez Chromatogram > 
Integrate (MS) pour afficher l'onglet 
Integrator.

b Cliquez sur l'onglet Suitability.
c Cochez la case Enable system 

suitability calculations.
d Sélectionnez United States 

Pharmacopoeia (USP).
e Dans la boîte Column void time, 

tapez 1.
f Dans la boîte Column length, 

tapez 3000.

• Notez le triangle bleu qui s'affiche 
lorsque vous changez la valeur d'un 
paramètre sauvegardée dans la 
méthode en cours. Lorsque vous 
enregistrez la méthode, les triangles 
disparaissent.

• Les algorithmes utilisés pour définir 
plusieurs des colonnes de la liste 
Integration Peak List changent en 
fonction de la pharmacopée 
sélectionnée. Pour plus 
d'informations, consultez l'aide 
en ligne.

Tâche 8. Intégration interactive d'un chromatogramme (SM) (suite)

Étapes Instructions détaillées Remarques
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Tâche 8. Calculez les valeurs d'adéquation du système (System Suitability)
Figure 16 Onglet Suitability de Chromatogram > Integrate (MS)

3 Réintégrer le chromatogramme. • Cliquez sur l'icône Intégrer le 
chromatogramme  dans la barre 
d'outils Method Editor pour effectuer 
l'intégration avec le nouveau 
paramètre.

4 Afficher les calculs d'adéquation 
du système.
• Ouvrir la fenêtre Integration 

Peak List.
• Réviser les valeurs de la zone de 

bruit et calculer le rapport 
signal/bruit pour les pics 
intégrés.

a Cliquez sur View > Integration Peak 
List.

b Cliquez avec le bouton de la souris 
dans l'en-tête de la fenêtre Peaks et 
cliquez sur Floating.

c Cliquez avec le bouton droit de la 
souris dans l'en-tête d'une colonne 
que vous ne souhaitez pas voir et 
cliquez sur Remove Column. 

d Cliquez avec le bouton droit de la 
souris dans l'en-tête d'une colonne et 
cliquez sur Add/Remove Columns 
pour changer les colonnes visibles.

• Les calculs d'adéquation du 
système sont inclus dans le tableau 
Integration Peak List.

• Les valeurs incluses sont 
notamment les suivantes: k’, Tailing 
factor, Plates, Plates/M et 
Symmetry.

• Vous pouvez également activer les 
calculs d'adéquation du système 
pour un chromatogramme SM, 
SM/SM ou SPG.

Figure 17 Tableau des pics intégrés avec valeurs d'adéquation du 
système

Tâche 8. Intégration interactive d'un chromatogramme (SM) (suite)

Étapes Instructions détaillées Remarques

Les valeurs réelles de Column 
void time et Column length 
pour ces fichiers de données 
sont différentes de ces valeurs. 
Celles-ci ne sont utilisées qu'à 
titre d'exemple.
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Tâche 8. Calculez les valeurs d'adéquation du système (System Suitability)
5 Restaurer les paramètres de la 
méthode par défaut, fermer les 
fenêtres Method Editor et 
Integration Peak List.

a Pour annuler vos modifications et 
restaurer les valeurs de la méthode par 
défaut, cliquez sur l'icône Restaurer 
les dernières valeurs enregistrées du 
fichier  dans la barre d'outils 
Method Editor. 

b Fermez la fenêtre Method Editor.
c Cliquez avec le bouton de la souris 

dans la fenêtre Integration Peak List et 
cliquez sur Floating.

d Cliquez sur View > Integration Peak 
List.

• Lorsque vous cliquez sur l'option 
Floating dans le menu contextuel 
pour la seconde fois, la fenêtre 
Integration Peak List est ancrée à 
son emplacement d'origine.

Tâche 8. Intégration interactive d'un chromatogramme (SM) (suite)

Étapes Instructions détaillées Remarques
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Tâche 9. Extraction de spectres d'un chromatogramme
Tâche 9. Extraction de spectres d'un chromatogramme

Au cours de cette tâche, vous allez extraire un spectre exactement à l'endroit 
que vous spécifiez dans le chromatogramme. Le programme d'analyse 
qualitative extrait un spectre à parti d'un point de données spécifique ou 
extrait un spectre moyen d'une moyenne de plusieurs points ou plages de 
données. 

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques

1 Parcourir un chromatogramme 
pour afficher l'ion précurseur et 
l'ion produit pour les quelques 
derniers pics de Pest - STD 200 
MRM.d.
• Effectuer un zoom avant sur 

la zone comprise entre 13 et 
16 minutes.

• Utiliser l'icône Walk 
Chromatogram.

• Réviser le spectre en 
commençant environ à 
13minutes et déplacer la flèche 
vers la droite. 

a Sélectionnez la ligne Pest - 200 - 
MRM.D dans la fenêtre Data 
Navigator.

b Fermez la fenêtre Method Editor.
c Fermer la fenêtre MS Spectrum 

Results.
d Cliquez sur le chromatogramme TIC 

MRM dans la fenêtre Data Navigator.
e Cliquez sur l'icône Autoscale Y-axis 

during Zoom  dans la barre d'outils 
Chromatogram Results.

f Sélectionnez 1 pour le nombre 
maximum de volets liste.

g Pour effectuer un zoom avant sur 
quelques pics, cliquez avec le bouton 
droit de la souris au-dessus du pic à 
13minutes et faites glisser le pointeur 
jusqu'à 16minutes, puis relâchez le 
bouton de la souris. 

h Cliquez sur l'icône Walk 
Chromatogram  dans la barre 
d'outils Chromatogram Results.

i Déplacez le curseur Walk 
Chromatogram jusqu'au dessus de 
l'axeX à environ 13minutes et cliquez. 

j Pour naviguer d'un spectre à l'autre, 
utilisez les touches fléchées droite et 
gauche de votre clavier.

• L'outil Walk Chromatogram est 
particulièrement utile sur les 
données SM/SM pour identifier les 
ions précurseur et produit.

• Le spectre de chaque point sur 
lequel vous cliquez dans la fenêtre 
Chromatogram Results s'affiche 
instantanément dans la fenêtre 
Spectrum Preview qui s'ouvre 
automatiquement.

• Parfois, deux spectres sont affichés 
dans la fenêtre Spectrum Preview. 
Par exemple, deux spectres sont 
affichés dans la fenêtre Spectrum 
Preview pour chacun des points sur 
lesquels vous cliquez près du pic 
situé à 13,431min.
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Apprendre les bases de l'analyse qualitative 1
Tâche 9. Extraction de spectres d'un chromatogramme
Figure 18 Parcours du chromatogramme pour visualiser les deux spectres MRM pour le pic situé à 13,43min

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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2 Extraire les spectres à des points 
de données spécifiques pour le pic 
à 5,2min et celui à 14,3min du 
fichier de données Pest - STD 200 
MRM.d.
• Extraire un spectre du pic situé à 

ou proche de 5,2min, puis l'un 
des creux, à l'aide de l'une des 
options décrites sous 
Comments.

• Extraire un spectre du pic situé à 
ou proche de 14,3minutes (pas le 
creux tout de suite).

• Changer l'affichage afin de 
visualiser au moins trois 
spectres.

a Cliquez sur l'icône Range Select  
dans la barre d'outils Chromatogram 
Results.

b Fermez la fenêtre Spectrum Preview.
c Cliquez sur l'icône Zoom Out  dans 

la barre d'outils Chromatogram 
Results.

d Pour effectuer un zoom avant sur le pic 
à 5,2min, cliquez avec le bouton droit 
de la souris au-dessus du pic à 4,0min 
et faites glisser le pointeur jusqu'à 
6,0min, puis relâchez le bouton. 

e Sur un pic proche de 5,2min, extrayez 
un spectre à l'aide de l'une des 
méthodes indiquées dans la colonne 
Remarques.

f Sur un creux proche de 5,1min, 
extrayez le spectre.

g Cliquez sur l'icône Zoom Out  dans 
la barre d'outils Chromatogram 
Results.

h Effectuez un zoom sur la zone 
comprise entre 14 et 15minutes. 

i Sur un pic proche de 14,3min, extrayez 
un spectre à l'aide de l'une des 
méthodes indiquées dans la colonne 
Remarques (n'extrayez pas encore le 
spectre du creux).

j Si nécessaire, sélectionnez 4 comme 
nombre maximum de volets liste dans 
la barre d'outils MS Spectrum Results.

• Lorsque vous effectuez le zoom, 
veillez à ce que l'icône AutoScale 
Y-axis during Zoom  soit 
sélectionnée. Le fond de l'icône est 
orange quand elle est active.

• Vous pouvez extraire un spectre de 
l'une des manières suivantes:
• Double-cliquez sur le point de 

données dans le 
chromatogramme. 

• Cliquez sur le point de données 
dans le chromatogramme, puis 
cliquez avec le bouton droit de la 
souris n'importe où dans le 
chromatogramme. Cliquez sur 
Extract MS Spectrum. La boîte 
de dialogue Extract Spectrum 
s'ouvre. Assurez-vous que le 
fichier Pest - STD 200 MRM.d 
est sélectionné, puis cliquez sur 
Extract dans la boîte de dialogue 
Extract Spectrum.

• Notez que la première fois que vous 
extrayez un spectre, la fenêtre MS 
Spectrum Results s'affiche 
contenant le spectre. Le type du 
spectre et le temps de rétention 
figurent sous User Spectra. Tous les 
spectres extraits suivants 
apparaissent aux deux endroits 
également.

• Lorsque vous extrayez un spectre 
SM du pic proche de 14,3minutes, 
deux spectres sont extraits, car 
deux transitions se produisent sur 
ce pic.

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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Apprendre les bases de l'analyse qualitative 1
Tâche 9. Extraction de spectres d'un chromatogramme
Figure 19 Fenêtre principale avec deux spectres MRM du pic situé à 5,2min et deux spectres MRM du pic 
situé à 14,3min

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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3 Extraire un spectreMS pour le 
creux situé à 14,35minutes du 
fichier de données Pest - STD 200 
MRM.d. 
• Ouvrir Spectrum Preview.
• Extraire un spectre du creux 

situé au TR 14,3min.
• Copier ce spectre dans le dossier 

User Spectra.
• Changer l'affichage pour 

montrer 6spectres.
• Fermer Spectrum Preview.

a Cliquez sur l'icône Spectrum Preview 
.

b Extrayez un spectre sur un creux 
proche de 14,3minutes.

c Cliquez avec le bouton droit de la 
souris sur le spectre dans la fenêtre 
Spectrum Preview, puis cliquez sur 
Copy to User Spectra. Les spectres 
sont copiés dans la section User 
Spectra du navigateur de données et 
s'affichent dans la fenêtre MS 
Spectrum Results.

d Cliquez sur la flèche vers le bas en 
regard de la liste de spectres et 
sélectionnez 6.

e Fermez la fenêtre Spectrum Preview.

• Lorsque Spectrum Preview est 
activé, le système affiche tous les 
spectres sélectionnés 
manuellement dans la fenêtre 
Spectrum Preview, mais pas dans la 
section User Spectra de Data 
Navigator.

• Avec Spectrum Preview activé, 
Qualitative Analysis écrase le 
précédent spectre lorsque vous en 
extrayez un nouveau.

• Le mode Spectrum Preview est utile 
si vous souhaitez réviser 
rapidement les spectres dans votre 
chromatogramme et n'en 
sauvegarder que quelques-uns.

Figure 20 Fenêtres Chromatogram Results et MS Spectrum Results

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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Tâche 9. Extraction de spectres d'un chromatogramme
4 Extraire un spectre qui moyenne 
tous les points d'une plage 
spécifiée pour le pic de 14,3min 
pour le fichier de données Pest - 
STD 200 MRM.d:
• Effectuer un zoom arrière.
• Utiliser l'icône de sélection de la 

plage dans la barre d'outils du 
chromatogramme.

• Définir la plage sur la totalité du 
pic. 

• Extraire le spectre à l'aide de 
l'une des options indiquées.

a Cliquez sur l'icône Range Select  
dans la barre d'outils du 
chromatogramme.

b Cliquez à gauche de la base du pic à 
14,3min et faites glisser le pointeur 
jusqu'à la droite de la base de ce 
même pic. 

c Extrayez le spectre moyen à l'aide de 
l'une des options indiquées à droite.

d Sélectionnez 2 comme nombre 
maximum de volets liste dans la 
fenêtre Chromatogram Results.

• Vous pouvez extraire un spectre 
moyen en double-cliquant sur la 
plage sélectionnée dans le 
chromatogramme. 

• Ou, cliquez avec le bouton droit de 
la souris n'importe où dans le 
chromatogramme, puis cliquez sur 
Extract MS Spectrum du menu 
contextuel.

• Notez que deux spectres MRM 
moyennés s'affichent.

Figure 21 Fenêtres Chromatogram Results et MS Spectrum Results affichant deux spectres moyennés

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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Tâche 9. Extraction de spectres d'un chromatogramme
5 Extraire des spectres qui 
moyennent les plages des pics 
situés à 5,2min et 14,3min pour le 
fichier de données Pest - STD 200 
MRM.d.
• Astuce: utiliser l'icône Range 

Select et la touche Ctrl pour 
sélectionner la plage du pic1 à 
mi-parcours.

• Extraire les spectres à l'aide de 
l'une des options indiquées à 
droite.

a Cliquez sur l'icône Zoom Out  dans 
la barre d'outils Chromatogram 
Results.

b Appuyez sur la touche Ctrl et 
maintenez-la enfoncée.

c Cliquez à gauche du pic de 5,2min et 
faites glisser le pointeur à droite de ce 
pic, puis relâchez le bouton de la 
souris.

d Relâchez la touche Ctrl.
e Extrayez les spectres moyennés à 

l'aide de cette option ou de l'une de 
celles qui figurent à droite:
• Double-cliquez dans la plage 

sélectionnée de l'un des pics.

• N'oubliez pas qu'une plage a déjà 
été sélectionnée à l'étape4 pour le 
deuxième pic.

• Pour extraire des spectres, vous 
pouvez également cliquer avec le 
bouton droit de la souris n'importe 
où dans le chromatogramme, puis 
cliquer sur Extract MS Spectrum. 
La boîte de dialogue Extract 
Spectrum s'affiche. Cliquez sur 
Extract.

Figure 22 Deux spectres moyennés à partir de deux plages différentes dans le chromatogramme

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques

Le premier spectre comporte des 
transitions entre les deux plages de 
temps. Le deuxième spectre n'a 
qu'une seule plage de temps, car la 
transition 160.00 -> ** ne figure pas 
dans le pic situé à 5,2minutes.
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Apprendre les bases de l'analyse qualitative 1
Tâche 9. Extraction de spectres d'un chromatogramme
6 Soustraire un spectre de fond 
chaque fois que vous extrayez un 
spectre de pic de Pest - STD 200 
MRM.d.
• Supprimer tous les balayages 

sous User Spectra dans Data 
Navigator.

• Extraire un spectre de fond qui 
est la moyenne d'un spectre au 
début du pic et d'un autre à la fin 
du pic.

• Extraire un spectre de pic des 
pics intégrés.

a Cliquez sur la ligne User Spectra dans 
Data Navigator. Cliquez avec le bouton 
droit de la souris sur la ligne User 
Spectra, puis cliquez sur Delete.

b Cliquez sur Yes.
c Dans Method Explorer, sélectionnez 

Spectrum > Extract (MS/MS). 
d Cliquez sur l'onglet Peak Spectrum 

Extraction (MS/MS), s'il n'est pas 
visible.

e Dans la boîte Peak spectrum 
background MS/MS, sélectionnez 
Average of spectra at peak start and 
end.

f Dans la barre d'outils Chromatogram 
Results, cliquez sur l'icône Peak 
Select .

g Cliquez sur l'option Chromatograms > 
Integrate.

h Sélectionnez le pic à 5,206minutes.
i Cliquez avec le bouton droit de la 

souris, puis sélectionnez l'option 
Extract Peak Spectrum du menu 
contextuel.

• Notez qu'à la fin de cette procédure, 
le spectre de fond désigné est 
automatiquement soustrait de tous 
les spectres de pic extraits.

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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1 Apprendre les bases de l'analyse qualitative
Tâche 9. Extraction de spectres d'un chromatogramme
Figure 23 Spectres de pic avec spectre de fond soustrait

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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Apprendre les bases de l'analyse qualitative 1
Tâche 9. Extraction de spectres d'un chromatogramme
7 Intégrer et extraire des spectres de 
pic du fichier de données Pest - 
STD 200 MRM.d.

a Cliquez sur le chromatogramme TIC 
MRM dans la fenêtre Data Navigator.

b Cliquez sur Chromatograms > 
Integrate and Extract Peak Spectra.

• Les spectres de pic que vous avez 
extraits manuellement à l'étape 
précédente sont automatiquement 
supprimés, car par défaut la case 
Clear previous peak spectra est 
cochée dans l'onglet 
Chromatograms > Integrate 
(MS/MS) > Results.

Figure 24 Intégration et extraction de spectres de pic

8 Supprimer les résultats 
d'intégration et les spectres de pic.

a Sélectionnez le fichier de données 
Pest - Std 200 MRM.d.

b Cliquez sur Chromatograms > Clear 
Results > Include Peak Spectra.

• Vous pouvez également cliquer sur 
Chromatograms > Clear Results > 
Only Chromatograms si vous ne 
voulez pas supprimer les spectres 
de pic.

Tâche 9. Extraction de spectres d'un chromatogramme

Étapes Instructions détaillées Remarques
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1 Apprendre les bases de l'analyse qualitative
Tâche 10. Ajout d'annotations
Tâche 10. Ajout d'annotations

Vous pouvez ajouter une annotation sous forme d'image ou de texte dans les 
fenêtres graphiques suivantes:

• Fenêtre Chromatogram Results

• Fenêtre MS Spectrum Results

Si vous enregistrez les résultats pour le fichier de données, les annotations 
sont également sauvegardées.

Tâche 10. Ajout d'annotations

Étapes Instructions détaillées Remarques

1 Sélectionner le fichier de données 
MSD_mix_4stds_DG_spl200_03.d. 
Masquer les autres 
chromatogrammes.

a Cochez la case en regard de 
MSD_mix_4stds_DB_spl200_03.d 
dans la fenêtre Data Navigator.

b Cliquez sur Edit > Show > Only 
Highlighted.

• Les chromatogrammes des autres 
fichiers de données sont 
automatiquement masqués.

2 Sélectionner l'emplacement dans 
le chromatogramme pour ajouter 
une annotation texte.

a Dans la fenêtre Chromatogram Results, 
cliquez sur l'outil Annotation  
dans la barre d'outils.

b Déplacez le curseur à l'emplacement 
du chromatogramme où vous 
souhaitez ajouter l'annotation.

c Cliquez avec le bouton droit de la 
souris, puis sélectionnez Add Text 
Annotation.

• Le curseur se transforme en 
réticule. Il permet de sélectionner 
l'emplacement exact pour l'ajout de 
l'annotation.

• La barre d'outils Annotate est 
disponible dans la fenêtre 
Chromatogram Results.

• Vous pouvez également ajouter des 
annotations à la fenêtre MS 
Spectrum Results.
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Apprendre les bases de l'analyse qualitative 1
Tâche 10. Ajout d'annotations
3 Ajouter les informations de 
l'annotation texte dans la boîte de 
dialogue Add/Edit Text Annotation.

a Saisissez le texte de l'annotation.
b Sélectionnez la couleur du texte (Text 

color).
c Sélectionnez l'Orientation.
d Sélectionnez le style et la taille de 

police (Font style et Font size).
e Cliquez sur Anchored (ancré) ou 

Floating (flottant). Si vous cliquez sur 
Anchored, sélectionnez les options du 
pointeur pour l'annotation texte. Si 
vous sélectionnez Floating, vous 
pouvez modifier la position relative. Il 
est plus simple de changer la position 
de manière interactive dans la fenêtre 
de graphiques.

f Cliquez sur OK.

• Vous pouvez ajouter plusieurs 
annotations dans un 
chromatogramme ou un spectre.

• Utilisez les icônes de la barre 
d'outils Annotate pour sélectionner 
toutes les annotations, supprimer et 
éditer des annotations.

Figure 25 Boîte de dialogue Add/Edit Text Annotation et fenêtre Chromatogram Results

Tâche 10. Ajout d'annotations (suite)

Étapes Instructions détaillées Remarques

La barre d'outils Annotate est disponible uniquement lorsque 
l'outil Annotate est sélectionné.
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Tâche 10. Ajout d'annotations
4 Sélectionner l'emplacement dans 
le chromatogramme pour ajouter 
une annotation image.

a Déplacez le curseur à l'emplacement 
du chromatogramme où vous 
souhaitez ajouter l'annotation.

b Cliquez avec le bouton droit de la 
souris, puis sélectionnez Add Image 
Annotation.

• Vous pouvez ajouter un fichier 
image JPG ou MOL.

5 Ajouter les informations de 
l'annotation texte dans la boîte de 
dialogue Add/Edit Text Annotation.

a Saisissez le texte de l'annotation.
b Tapez 50 dans la boîte Scale width.
c Cochez la case Lock aspect ratio.
d Cliquez sur Floating. Vous pouvez 

changer la position relative. Il est plus 
simple de changer la position de 
manière interactive dans la fenêtre de 
graphiques.

e Cliquez sur OK.
f Déplacez l'image dans le coin 

supérieur droit du chromatogramme.

• Le fichier Agilent_Logo.tif réside 
dans le dossier \\MassHunter\
Report Templates\Qual\B.05.00\
en-US\Letter. Vous devez le 
convertir en fichier JPG.

• Vous pouvez ajouter plusieurs 
annotations dans un 
chromatogramme ou un spectre.

Figure 26 Boîte de dialogue Add/Edit Image Annotation et fenêtre Chromatogram Results

Tâche 10. Ajout d'annotations (suite)

Étapes Instructions détaillées Remarques
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Tâche 10. Ajout d'annotations
6 Effectuer un zoom avant sur le 
premier pic.

• Effectuez un zoom sur une zone autour 
du premier pic à 5,5minutes.

Figure 27 Boîte de dialogue Add/Edit Image Annotation et fenêtre Chromatogram Results

7 Rebasculer sur l'outil Range Select 
dans la fenêtre Chromatogram 
Results. Supprimer d'abord 
l'annotation.

a Cliquez sur l'icône  pour 
supprimer toutes les annotations.

b Cliquez sur l'icône Range Select  
dans la barre d'outils Chromatogram 
Results.

• Si vous voulez enregistrer les 
annotations avec les résultats du 
fichier de données, reportez-vous à 
la « Tâche 17. Enregistrement des 
résultats », page 72.

• Vous pouvez basculer entre cinq 
outils différents dans la barre 
d'outils Chromatogram Results. 
Pour plus d'informations, 
reportez-vous à l'aide en ligne. Les 
cinq outils sont les suivants:
• Range Select
• Select Peak...
• Manual Integration
• Walk Chromatogram
• Annotation Mouse

Tâche 10. Ajout d'annotations (suite)

Étapes Instructions détaillées Remarques

Si une annotation est ancrée, elle reste fixée 
à la position à laquelle elle est ancrée. Si 
vous zoomer sur un autre pic, il se peut 
qu'une annotation ancrée ne soit pas visible. 
Si une annotation est flottante, elle est 
toujours affichée à la même position relative 
dans le coin supérieur gauche de la fenêtre.
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Tâche 11. Ajout d'un compas d'épaisseur de masse
Tâche 11. Ajout d'un compas d'épaisseur de masse

Un compas d'épaisseur (caliper) montre la différence entre deux points d'un 
spectre. Vous pouvez en ajouter un dans la fenêtre MS Spectrum Results.

Si vous enregistrez les résultats pour le fichier de données, les compas 
d'épaisseur sont également sauvegardés.

Tâche 11. Ajout d'un compas d'épaisseur de masse

Étapes Instructions détaillées Remarques

1 Intégrer et extraire des spectres de 
pic de 
MSD_mix_4stds_DG_spl200_03.d.

a Cochez la case en regard de 
MSD_mix_4stds_DB_spl200_03.d 
dans la fenêtre Data Navigator.

b Cliquez sur Edit > Show > Only 
Highlighted.

c Cliquez sur Chromatograms > 
Integrate and Extract Peak Spectra.

d Fermez la fenêtre Method Editor.

2 Ajouter le compas d'épaisseur au 
spectre de pic créé au cours de la 
précédente tâche.

a Dans la fenêtre MS Spectrum Results, 
cliquez sur l'outil Delta Mass Caliper 

 dans la barre d'outils.
b (facultatif) Sélectionnez Profile Point 

to Point pour le type de compas 
d'épaisseur dans la barre d'outils 
Caliper.

c Effectuez un zoom avant de 66 à 
132 m/z.

d Déplacez le curseur à l'emplacement 
du volet du spectre où vous souhaitez 
ajouter le compas d'épaisseur.

e Faites glisser le curseur jusqu'au point 
final du compas dans le spectre. À 
mesure que vous faites glisser le 
curseur, la valeur de masse Delta 
change. Lorsque vous relâchez le 
bouton de la souris, le compas 
d'épaisseur est ajouté. 

• Le curseur se change en flèche. Il 
permet de sélectionner le point de 
début et le point de fin du compas 
d'épaisseur. 

• Vous ne pouvez pas sélectionner le 
type de compas d'épaisseur si le 
spectre est centroïde, car Profile 
Point to Point n'a pas d'effet sur les 
données centroïdes.

• Le curseur triangle est défini en 
haut du pic sélectionné.
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Tâche 11. Ajout d'un compas d'épaisseur de masse
3 Modifier le compas d'épaisseur 
pour utiliser une autre couleur.

a Cliquez sur le compas d'épaisseur créé 
à l'étape précédente.

b Cliquez sur le bouton Caliper 
Properties  dans la barre d'outils 
MS Spectrum Results Caliper.

c (facultatif) Entrez les valeurs de Start 
X et Start Y.

d Sélectionnez la couleur du texte (Text 
color).

e Sélectionnez le style et la taille de 
police (Font style et Font size).

f Cliquez sur OK.

• Vous pouvez ajouter plusieurs 
compas d'épaisseur à un spectre.

• Utilisez les icônes de la barre 
d'outils Caliper pour sélectionner 
tous les compas d'épaisseur, 
supprimer et éditer des compas 
d'épaisseur.

Figure 28 Boîte de dialogue Delta Mass Caliper Settings et fenêtre MS Spectrum Results

4 Supprimer des résultats 
d'intégration et des spectres.

a Cliquez sur Chromatograms > Clear 
Results > Include Peak Spectra.

b Cliquez sur l'outil Range Select.

• Si vous voulez enregistrer les 
compas d'épaisseur avec les 
résultats du fichier de données, 
reportez-vous à la « Tâche 17. 
Enregistrement des résultats », 
page 72.

Tâche 11. Ajout d'un compas d'épaisseur de masse (suite)

Étapes Instructions détaillées Remarques
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Tâche 11. Ajout d'un compas d'épaisseur de masse
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Logiciel pour le poste de travail Agilent MassHunter Analyse qualitative
Guide de familiarisation
2
Détection et identification

Tâche 12. Détection de composés par déconvolution de 
chromatogramme 50

Tâche 13. Identification de composés à l'aide de l'algorithme de recherche 
en bibliothèque 54

Tâche 14. Détection de composés par MRM (MRM uniquement) 59

Tâche 15. Détection de composés par intégration 63

Tâche 16. Génération de formules et recherche en bibliothèque pour des 
spectres de pic 66

Tâche 17. Enregistrement des résultats 72

Au cours de ces tâches, vous allez détecter et identifier des composés dans des 
fichiers de données CPG/SM.

Chaque exercice est présenté dans un tableau à trois colonnes:

• Étapes: utilisez ces instructions générales afin d'explorer le programme par 
vous-même.

• Instructions détaillées: utilisez-les si vous avez besoin d'aide ou si vous 
préférez suivre une méthode d'apprentissage pas à pas.

• Remarques: lisez-les pour obtenir des astuces et des informations 
supplémentaires sur chaque étape de l'exercice.
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2 Détection et identification
Tâche 12. Détection de composés par déconvolution de chromatogramme
Tâche 12. Détection de composés par déconvolution de 
chromatogramme

L'algorithme de détection des composés identifie les composés dans des 
données CPG/SM et crée un spectre SM nettoyé pour chaque composé. Cette 
fonctionnalité est un moyen simple d'analyser les informations de données 
complexes. L'algorithme de détection de composés par dévolution de 
chromatogramme ne peut être utilisé que sur des échantillons de données 
CPG/SM acquises en mode Scan, Product Ion scan ou Neutral Loss scan.

Cette tâche explique la détection de composés par déconvolution de 
chromatogramme avec des données de masse précises. Vous pouvez également 
détecter des composés par déconvolution de chromatogramme avec des 
données de masse unitaire après avoir au préalable changé la fenêtre 
d'extraction.

Tâche 12. Détection de composés à l'aide de la déconvolution de chromatogramme (CPG/SM)

Étape Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données 
MSD_mix_4stds_DG_spl200_03.d
.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data et cliquez sur Open.

• L'algorithme de détection des 
composés par déconvolution de 
chromatogramme fonctionne avec 
des fichiers de données CPG/QQQ 
et CPG/Q-TOF.

Figure 29 Chromatogramme CIT à partir de Pest - 200 - Scan.d
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Détection et identification 2
Tâche 12. Détection de composés par déconvolution de chromatogramme
2 Configurer l'interface utilisateur 
pour travailler avec des données 
CPG.

• Suivez les instructions de la « Tâche 2. 
Configuration de l'interface utilisateur 
pour des données CPG/SM », page 13.

• Pour ces exemples, chargez le flux 
de travaux GC/Q-TOF Compound 
Screening.

3 Détecter des composés à l'aide de 
l'algorithme de déconvolution de 
chromatogramme.
• Sélectionner l'intégrateur Agile.
• Entrer un seuil SNR de 20.
• Entrer 100ppm comme valeur de 

Left m/z delta et Right m/z 
delta.

a Dans la fenêtre Method Explorer, 
sélectionnez Find Compounds > Find 
by Chromatogram Deconvolution.

b Dans l'onglet Settings sous Peak filter, 
tapez 20 comme valeur de SNR 
threshold.

c Sélectionnez PPM pour m/z delta 
units.

d Entrez 100 pour Left m/z delta et 
100 également pour Right m/z delta.

• La section Find by Chromatogram 
Deconvolution est également 
disponible dans la section 
GC/Q-TOF Compound Screening.

• Si vous disposez de données de 
masse unitaire, entrez 0.3 AMU 
comme valeur de Left m/z delta et 
0.7 AMU pour Right m/z delta.

• Vous pouvez extraire l'ensemble 
des résultats complets pour un 
composé une fois détecté à l'aide 
de l'option de menu Compounds > 
Extract Complete Result Set 
lorsqu'un composé est sélectionné.

Figure 30 Onglet Settings dans la section Find by Chromatogram 
Deconvolution

Tâche 12. Détection de composés à l'aide de la déconvolution de chromatogramme (CPG/SM)

Étape Instructions détaillées Remarques
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2 Détection et identification
Tâche 12. Détection de composés par déconvolution de chromatogramme
• Sélectionner pour extraire des 
spectres CIE, SM et SM/SM.

e Cliquez sur l'onglet Results.
f Cochez les cases Extract EIC, Extract 

ECC, Extract cleaned spectrum et 
Extract raw spectrum.

g Cliquez sur  pour exécuter 
l'algorithme Find Compounds by 
Chromatogram Deconvolution sur le 
fichier de données. 

h Si nécessaire, cliquez sur l'option 
View > Compound List.

• Le programme d'analyse qualitative 
détecte 4composés répondant aux 
conditions.

• Si le fichier de données n'est pas 
indexé, l'exécution de l'algorithme 
peut prendre beaucoup de temps.

4 Examiner les composés. Voir la 
Figure 31, page 53.

a Sélectionnez 2 comme nombre 
maximum de volets liste dans la barre 
d'outils MS Spectrum Results.

b Cliquez sur l'icône Hide Empty 
Columns dans la fenêtre Compound 
List.

c Cliquez sur le premier composé dans la 
fenêtre Data Navigator. 

d Lorsque la fenêtre Data Navigator est 
active, utilisez les touches fléchées 
pour passer d'un composé à l'autre. 

• L'affichage des deux spectres est un 
bon moyen pour montrer toutes les 
informations d'un seul composé.

• Notez que le spectre nettoyé et le 
spectre brut sont affichés.

Tâche 12. Détection de composés à l'aide de la déconvolution de chromatogramme (CPG/SM)

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 12. Détection de composés par déconvolution de chromatogramme
Figure 31 Résultats de la détection de composés par déconvolution de chromatogramme

Tâche 12. Détection de composés à l'aide de la déconvolution de chromatogramme (CPG/SM)

Étape Instructions détaillées Remarques
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2 Détection et identification
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque
Tâche 13. Identification de composés à l'aide de l'algorithme de 
recherche en bibliothèque

Au cours de cette tâche, vous allez identifier et générer des formules pour les 
composés détectés au cours de la « Tâche 12. Détection de composés par 
déconvolution de chromatogramme », page 50. Vous pouvez exécuter cette 
tâche si vous avez fait l'acquisition de la bibliothèque NIST08.l ou si vous 
utilisez la bibliothèque demo.l. Si vous disposez de deux bibliothèques, vous 
pouvez même sélectionner les deux.
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Détection et identification 2
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque

Étape Instructions détaillées Remarques

1 Effectuer une recherche en librairie 
de tous les composés dans le 
fichier de données 
MSD_mix_4stds_DG_spl200_03.d.

a Sélectionnez les composés dans le 
fichier de données 
MSD_mix_4stds_DG_spl200_03.D 
dans la fenêtre Data Navigator.

b Dans la fenêtre Method Explorer, 
cliquez sur Identify Compounds > 
Search Unit Mass Library.

c Dans l'onglet Settings, cliquez sur le 
bouton Add Library. Sélectionnez la 
bibliothèque demo.l et cliquez sur le 
bouton OK.

d (facultatif) Dans l'onglet Settings, 
cliquez sur le bouton Add Library. 
Sélectionnez la bibliothèque NIST08.l 
et cliquez sur le bouton OK.

e Cliquez sur l'onglet Search Results.
f (facultatif) Sélectionnez Stop When 

Found pour Multi-Library search type.
g Cliquez sur Identify > Search Library 

for Compounds dans le menu 
principal. Vous pouvez également 
cliquer sur l'icône Search Library for 
Compounds  pour exécuter 
l'algorithme.

h Cliquez sur View > Difference 
Results.

i Cliquez sur View > Structure Viewer.
j Cliquez sur View > Compound 

Identification Results, si nécessaire 
pour afficher la fenêtre.

k Le cas échéant, cliquez sur l'onglet 
permettant d'afficher la fenêtre 
Compound Identification Results. 
L'onglet correspondant est accessible 
dans la fenêtre Chromatogram Results.

• Vous pouvez également cliquer sur 
GC/Q-TOF Compound Screening > 
Identify by Library Search dans 
Method Explorer. La même section 
s'affiche dans la fenêtre Method 
Editor.

• Demo.l et Nist08 doivent être 
installés dans le dossier \
MassHunter\Library.

• Notez que de nombreux composés 
sont identifiés après la recherche 
dans la bibliothèque NIST08.l.

• Si vous ne disposez pas de la 
bibliothèque NIST08.l, sélectionnez 
une autre bibliothèque si vous en 
avez une de disponible.

• Si vous avez deux ou plusieurs 
bibliothèques sélectionnées et que 
vous sélectionnez Stop When 
Found, l'algorithme de recherche en 
bibliothèque recherche dans la 
première bibliothèque de la liste. Si 
le composé est identifié, la 
recherche s'arrête. Si le composé 
n'est pas identifié, la recherche se 
poursuit dans la bibliothèque 
suivante jusqu'à ce qu'il soit 
identifié ou que la dernière 
bibliothèque ait été consultée.

• Le programme Library Editor permet 
de modifier les bibliothèques que 
vous utilisez avec l'algorithme 
Search Unit Mass Library. Ce 
programme est installé avec le 
programme Agilent MassHunter 
Quantitative Analysis. Cliquez sur 

l'icône  pour démarrer le 

programme.
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2 Détection et identification
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque
2 Afficher les colonnes Spectral 
Library Results dans la fenêtre 
Compound List et la fenêtre 
Compound Identification Results.

a Cliquez sur le bouton Show Library 
Search Columns  dans la barre 
d'outils Compound List et dans la barre 
d'outils Compound Identification 
Results.

b Cliquez sur le bouton Hide Empty 
Columns button  dans la barre 
d'outils Compound List et dans la 
fenêtre Compound Identification 
Results.

Figure 32 Composés du fichier de données MSD_mix_4stds_DG_spl200_03.D et résultats de la recherche en 
bibliothèque

Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque
3 Basculer vers Compound Details 
View pour réviser les composés.

a Cliquez sur  dans 
la barre d'outils principale.

b Fermez la fenêtre Compound 
Fragment Spectrum Results.

4 Réviser les résultats dans 
Compound Details View.

a Cliquez sur l'icône Overlaid dans la 
fenêtre Compound Chromatogram 
Results.

b Développez les résultats dans la 
fenêtre Compound Identification 
Results.

• Pour obtenir plus de détails sur 
Compound Details View, consultez 
l'aide en ligne. La vue Compound 
Details View est très utile pour 
examiner les résultats de 
l'algorithme Find by Formula avec 
un fichier de données acquis en 
mode All Ions.

Figure 33 Compound Details View montrant les composés du fichier de données 
MSD_mix_4stds_DG_spl200_03.D

Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque

Étape Instructions détaillées Remarques
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2 Détection et identification
Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque
5 Rebasculer vers Navigator View. • Cliquez sur le bouton 
 dans la barre 

d'outils principale.

6 Fermer le fichier de données. a Cliquez sur File > Close Data File.
b Cliquez sur No.

• Si vous souhaitez enregistrer ces 
résultats, reportez-vous à la « Tâche 
17. Enregistrement des résultats », 
page 72.

Tâche 13. Identification de composés à l'aide de l'algorithme de recherche en bibliothèque

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 14. Détection de composés par MRM (MRM uniquement)
Tâche 14. Détection de composés par MRM (MRM uniquement)

L'algorithme Find Compounds by MRM identifie les composés dans des 
données MRM à partir d'un dispositif Triple Quadrupôle. L'algorithme 
recherche les composés à l'aide de transitions MRM. Tous les composés dans la 
méthode d'acquisition sont extraits et affichés dans la liste Compound List. 
Les composés ne sont pas éliminés en fonction des résultats d'intégration du 
chromatogramme. Vous ne pouvez utiliser l'algorithme Find Compounds by 
MRM que sur des données acquises à l'aide de transitions MRM. L'algorithme 
MRM utilise des informations trouvées dans le fichier de données si celui-ci est 
de type MRM.

Tâche 14. Détection de composés par MRM (MRM uniquement)

Étape Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données Pest - STD 200 MRM.d.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données Pest - 
STD 200 MRM.d dans le dossier du 
fichier d'exemples de données GC.

c Désélectionnez la case Load result 
data et cliquez sur Open.

• Utilisez le flux de travaux général 
(General Workflow) pour travailler 
avec des données CPG/QQQ. Vous 
pouvez utiliser ce même flux de 
travaux ou celui de criblage des 
composés CPG/Q-TOF pour 
travailler avec des données 
CPG/Q-TOF.

Figure 34 Chromatogramme CIT à partir de Pest - STD 200 MRM.d

2 Configurer l'interface utilisateur 
pour travailler avec des données 
CPG.

• Suivez les instructions de la « Tâche 2. 
Configuration de l'interface utilisateur 
pour des données CPG/SM », page 13.
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2 Détection et identification
Tâche 14. Détection de composés par MRM (MRM uniquement)
3 Détecter des composés à l'aide de 
l'algorithme MRM.

a Dans la fenêtre Method Explorer, 
sélectionnez Find Compounds > Find 
by MRM.

b Cliquez sur le bouton Group 
transitions by compound name.

c Cliquez sur l'onglet Integrator.
d Sélectionnez l'intégrateur Agile.

• Vous pouvez choisir la zone du 
chromatogramme dans laquelle 
vous envisager de détecter des 
composés. 

• Vous pouvez extraire l'ensemble 
des résultats complets pour un 
composé une fois détecté à l'aide 
de l'option de menu Compounds > 
Extract Complete Result Set 
lorsqu'un composé est sélectionné.

Figure 35 Onglet Integrator dans la section Find by MRM de Method Editor

e Cliquez sur  pour exécuter 
l'algorithme Find Compounds by 
MRM sur le fichier de données. 

f Si nécessaire, cliquez sur l'option 
View > Compound List.

g Si nécessaire, cliquez sur View > 
Compound Identification Results.

• Le programme d'analyse qualitative 
détecte 28composés répondant aux 
conditions.

Tâche 14. Détection de composés par MRM (MRM uniquement)

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 14. Détection de composés par MRM (MRM uniquement)
4 Examiner les composés. Voir la 
Figure 36, page 61.

a Sélectionnez 2 comme nombre 
maximum de volets liste dans la barre 
d'outils MS Spectrum Results.

b Cliquez sur l'icône Automatically 
Show Columns dans la fenêtre 
Compound List et dans la fenêtre 
Compound Identification Results.

c Cliquez sur le premier composé dans la 
fenêtre Data Navigator. 

d Lorsque la fenêtre Data Navigator est 
active, utilisez les touches fléchées 
pour passer d'un composé à l'autre. 

• L'ion précurseur est affiché dans la 
colonne Precursor (Acq Method) et 
l'ion produit dans la colonne 
Product (Acq Method) dans la 
fenêtre Compound Identification 
Results.

Figure 36 Résultats de la détection par MRM

Tâche 14. Détection de composés par MRM (MRM uniquement)

Étape Instructions détaillées Remarques
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2 Détection et identification
Tâche 14. Détection de composés par MRM (MRM uniquement)
5 Fermer le fichier de données. a Cliquez sur File > Close Data File.
b Cliquez sur Close.

• Si vous souhaitez enregistrer ces 
résultats, reportez-vous à la « Tâche 
17. Enregistrement des résultats », 
page 72.

Tâche 14. Détection de composés par MRM (MRM uniquement)

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 15. Détection de composés par intégration
Tâche 15. Détection de composés par intégration

L'algorithme Find Compounds by Integration identifie les composés en 
fonction des résultats d'intégration. Un composé est créé pour chaque pic 
identifié par l'intégrateur.

Tâche 15. Détection de composés par intégration

Étape Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données 
MSD_mix_4stds_DG_spl200_03.
D.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données Pest - 
STD 200 MRM.d dans le dossier du 
fichier d'exemples de données GC.

c Désélectionnez la case Load result 
data et cliquez sur Open.

• Utilisez le flux de travaux général 
(General Workflow) pour travailler 
avec des données CPG/QQQ. Vous 
pouvez utiliser ce même flux de 
travaux ou celui de criblage des 
composés CPG/Q-TOF pour 
travailler avec des données 
CPG/Q-TOF.

Figure 37 Chromatogramme CIT tiré de MSD_mix_4stds_DG_spl200_03.d

2 Configurer l'interface utilisateur 
pour travailler avec des données 
CPG.

• Suivez les instructions de la « Tâche 2. 
Configuration de l'interface utilisateur 
pour des données CPG/SM », page 13.

3 Détecter des composés à l'aide de 
l'algorithme d'intégration.

a Dans la fenêtre Method Explorer, 
sélectionnez Find Compounds > Find 
by Integration.

b Sélectionnez l'intégrateur MS/MS 
(GC).

• Vous pouvez choisir la zone du 
chromatogramme dans laquelle 
vous envisager de détecter des 
composés. 

• Vous pouvez extraire l'ensemble 
des résultats complets pour un 
composé une fois détecté à l'aide 
de l'option de menu Compounds > 
Extract Complete Result Set 
lorsqu'un composé est sélectionné.
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2 Détection et identification
Tâche 15. Détection de composés par intégration
Figure 38 Onglet Integrator dans la section Find by Integration de Method Editor

c Cliquez sur  pour exécuter 
l'algorithme Find Compounds by 
Integration sur le fichier de données. 

d Si nécessaire, cliquez sur l'option 
View > Compound List.

• Le programme d'analyse qualitative 
détecte 6composés répondant aux 
conditions.

4 Examiner les composés. Voir la 
Figure 36, page 61.

a Sélectionnez 2 comme nombre 
maximum de volets liste dans la barre 
d'outils MS Spectrum Results.

b Cliquez sur l'icône Automatically 
Show Columns dans la fenêtre 
Compound List.

c Cliquez sur le premier composé dans la 
fenêtre Data Navigator. 

d Lorsque la fenêtre Data Navigator est 
active, utilisez les touches fléchées 
pour passer d'un composé à l'autre. 

Tâche 15. Détection de composés par intégration

Étape Instructions détaillées Remarques
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Détection et identification 2
Tâche 15. Détection de composés par intégration
Figure 39 Résultats de la détection par intégration

5 Fermer le fichier de données. a Cliquez sur File > Close Data File.
b Cliquez sur Close.

• Si vous souhaitez enregistrer ces 
résultats, reportez-vous à la « Tâche 
17. Enregistrement des résultats », 
page 72.

Tâche 15. Détection de composés par intégration

Étape Instructions détaillées Remarques
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2 Détection et identification
Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic
Tâche 16. Génération de formules et recherche en bibliothèque pour 
des spectres de pic

Au cours de cette tâche, vous allez d'abord intégrer et extraire des spectres de 
pic du fichier de données CPG/Q-TOF. Ensuite, vous allez générer des formules 
possibles pour chacun des spectres de pic.

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données 
MSD_mix_4stds_DB_spl200_03.d.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DB_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data et cliquez sur Open.

• Si cette case n'est pas disponible, 
cela signifie qu'aucun résultat n'a 
été enregistré dans le fichier de 
données. Pour plus d'instructions 
sur l'enregistrement des résultats, 
se reporter à la « Tâche 17. 
Enregistrement des résultats », 
page 72.

2 Intégrer et extraire des spectres de 
pic.

a Cliquez dans la section Chromatogram 
> Integrate (MS) de la fenêtre Method 
Explorer.

b Cliquez sur l'onglet Peak Filters.
c Cliquez sur le bouton Peak height.
d Cochez la case Relative height.
e Cochez la case Limit (by height) to the 

largest et tapez 4.
f Cliquez sur Chromatograms > 

Integrate and Extract Peak Spectra.
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Détection et identification 2
Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic
3 Générer des formules pour chacun 
des spectres de pic.
• Afficher la liste Spectrum 

Identification Results List.
• Fermer la fenêtre MS Spectrum 

Results.

Astuce: pour obtenir les mêmes 
résultats que dans la Figure 41, veillez 
à sélectionner Common organic 
molecules comme modèle Isotope.

a Dans la fenêtre Method Explorer, 
cliquez sur Identify Compounds > 
Generate Formulas.

b Dans la fenêtre Method Editor, cliquez 
sur l'onglet Charge State et 
sélectionnez Common organic 
molecules comme modèle Isotope.

c Dans la fenêtre Data Navigator, 
sélectionnez tous les spectres dans la 
section User Spectra.

d Cliquez sur l'option Identify > 
Generate Formulas from Spectrum 
Peaks ou sur le bouton Generate 
Formulas from Spectrum Peaks  
pour exécuter l'algorithme.

e Si nécessaire, cliquez sur l'icône 
Spectrum Identification Results , 
ou sur l'option View > Spectrum 
Identification Results.

f Dans la fenêtre Spectrum 
Identification Results, cliquez sur le 
bouton Automatically Show Columns 
dans la barre d'outils.

g Cliquez sur l'icône Hide Empty 
Columns  dans la fenêtre 
Spectrum Identification Results.

h Sélectionnez C6 H13 comme meilleur 
(Best) résultat.

i Développez le tableau pour cette ligne.
j Fermez la fenêtre Method Editor.
k Révisez la formule et l'espèce de l'ion 

indiquées au-dessus de nombreux pics 
dans la fenêtre MS Spectrum Results. 
Toutes les formules et les espèces 
d'ions sont de la même couleur que le 
spectre.

• Vous pouvez voir les rapports des 
teneurs isotopiques prévus sur le 
tracé du spectre lorsque vous 
effectuez un zoom avant sur le 
rapport m/z approprié. Pour plus 
d'informations, consultez l'aide en 
ligne.

• L'icône Run  de la barre d'outils 
Method Editor vous permet parfois 
de choisir une action parmi 
plusieurs actions possibles. Par 
exemple, deux actions différentes 
sont possibles lorsque vous cliquez 
sur l'icône Run dans cette section. 
Si vous cliquez sur la flèche, une 
liste d'actions possibles s'affiche et 
vous pouvez choisir l'action à 
exécuter. Le fait de choisir une autre 
action dans la liste change l'action 
par défaut. Si vous cliquez 
simplement sur le bouton Run, 
l'action par défaut est effectuée.

• Vous pouvez modifier la largeur 
d'une colonne en tirant sur la ligne 
qui sépare deux colonnes 
adjacentes.

• Vous pouvez modifier une colonne 
en tirant sur l'en-tête de la colonne.

• Pour supprimer une colonne, 
cliquez sur Remove column dans le 
menu contextuel du tableau.

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques
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Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic
Figure 40 Résultats de la génération de formules pour les pics 1 à 4

4 Exécuter une recherche en librairie 
pour les spectres de pic 1 à 4.

a Dans la fenêtre Data Navigator, cliquez 
sur User Spectra.

b Dans la fenêtre Method Explorer, 
cliquez sur Identify Compounds > 
Search Unit Mass Library.

c Vérifiez qu'une bibliothèque valide est 
sélectionnée.

d Cliquez sur Identify > Search Library 
for Spectra dans le menu principal.

e Fermez la fenêtre Method Editor.

• Method Editor s'ouvre 
automatiquement lorsque vous 
cliquez sur une section de Method 
Explorer.

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques
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5 Modifier les colonnes visibles. a Cliquez avec le bouton droit de la 
souris dans la fenêtre Spectrum 
Identification Results et sélectionnez 
Add/Remove Columns. Dans la boîte 
de dialogue Enhanced) Add/Remove 
Columns, sélectionnez les colonnes à 
afficher. Cliquez sur OK.

b Fermez la fenêtre Method Editor.
c Cliquez sur l'icône Hide Empty 

Columns  dans la fenêtre 
Spectrum Identification Results.

d Révisez la formule et l'espèce de l'ion 
indiquées au-dessus de chaque pic 
dans la fenêtre MS Spectrum Results.

• Si vous utilisez l'option Remove 
Column et supprimez une colonne 
qui contient des données, le logiciel 
réaffiche automatiquement cette 
colonne si la fonction Automatically 
Show Columns est activée.

• L'algorithme LibSearch est 
largement pondéré dans la section 
Combine Identification Results de la 
méthode. Vous pouvez choisir 
manuellement le meilleur résultat 
MFG ou modifier la combinaison 
des résultats d'identification.

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques
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Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic
Figure 41 Résultats de la recherche en bibliothèque et de la génération de formules pour le premier spectre 
de pic

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques
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6 Réviser les résultats de chaque 
spectre dans la fenêtre MS Peaks 
One.

a Cliquez sur View >MS Spectrum Peak 
List 1.

b Cliquez avec le bouton droit de la 
souris et sélectionnez Add/Remove 
Columns.

c Vérifiez que les colonnes affichées 
dans la Figure 42 figurent dans la liste 
Show these columns.

d Triez la colonne Ion Type.
e Si le type d'ion est Fragment Ion, la 

formule et l'espèce de l'ion s'affichent 
en vert sur chaque pic dans la fenêtre 
MS Spectrum Results.

• Les ions fragments s'affichent en 
vert dans la fenêtre MS Spectrum 
Results.

• Le type d'ion peut être Molecular 
Ion, Fragment Ion ou vide. S'il s'agit 
d'un ion fragment, les colonnes 
Loss Formula et Loss Mass 
affichent la formule et la masse à 
prendre en compte pour arriver à cet 
ion à partir de l'ion moléculaire. La 
colonne Formula & Ion Species 
indique la formule et l'espèce pour 
l'ion en question.

Figure 42 Tableau MS Peaks One avec les colonnes Ion Type, Loss Formula, Loss Mass 
et Formula & Ion Species

7 (facultatif) Fermer le fichier de 
données.
• Vous pouvez passer à la tâche 

suivante pour savoir comment 
enregistrer les résultats.

a Cliquez sur File > Close Data File.
b Cliquez sur Close.

• Si vous souhaitez enregistrer ces 
résultats, reportez-vous à la « Tâche 
17. Enregistrement des résultats », 
page 72.

Tâche 16. Génération de formules et recherche en bibliothèque pour des spectres de pic

Étape Instructions détaillées Remarques
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Tâche 17. Enregistrement des résultats
Tâche 17. Enregistrement des résultats

Au cours de cette tâche, vous allez enregistrer les résultats pour le fichier de 
données en cours.

Tâche 17. Enregistrement des résultats

Étape Instructions détaillées Remarques

1 Enregistrer les résultats pour le 
fichier de données en cours et 
fermer le fichier de données.

a Cliquez sur File > Save Results.
b Cliquez sur File > Close Data File.

• Vous ne pouvez enregistrer qu'un 
seul jeu de résultats avec un fichier 
de données. Si vous avez déjà 
enregistré des résultats pour le 
fichier de données en cours, ils sont 
écrasés lorsque vous cliquez sur 
File > Save Results.

2 Ouvrir le fichier de données et 
charger les résultats.

a Cliquez sur File > Open Data File. La 
boîte de dialogue Open Data File 
s'ouvre.

b Sélectionnez un fichier de données. 
Pour cet exemple, sélectionnez le 
fichier de données 
MSD_mix_4stds_DG_spl200_03.d.

c Cochez la case Load result data.
d Cliquez sur le bouton Open.
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Tâche 17. Enregistrement des résultats
Figure 43 Boîte de dialogue Open Data File

3 Examiner les résultats. a Sélectionnez la fenêtre Spectrum 
Identification Results.

b Révisez les résultats.

•

Tâche 17. Enregistrement des résultats

Étape Instructions détaillées Remarques

La case Load result data est cochée.
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Tâche 17. Enregistrement des résultats
Figure 44 Résultats de la recherche en bibliothèque et de la génération de formules pour le premier spectre 
de pic

4 Fermer le fichier de données. a Cliquez sur File > Close Data File.
b Cliquez sur Close.

5 Ouvrir à nouveau le fichier de 
données et ne pas charger les 
résultats.

a Cliquez sur File > Open. La boîte de 
dialogue Open Data File s'ouvre.

b Sélectionnez un fichier de données. 
Pour cet exemple, sélectionnez le 
fichier de données 
MSD_mix_4stds_DG_spl200_03.d.

c Désélectionnez la case Load result 
data.

d Cliquez sur le bouton Open.

• Si vous ne chargez pas de résultats, 
un CIT par défaut s'ouvre lorsque 
vous ouvrez un fichier de données. 
Si vous sélectionnez les actions 
Run ‘File Open’ dans la boîte de la 
méthode sélectionnée, les actions 
File Open sont exécutées à la place. 
Pour plus d'informations, consultez 
l'aide en ligne.

Tâche 17. Enregistrement des résultats

Étape Instructions détaillées Remarques
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Tâche 17. Enregistrement des résultats
Figure 45 Résultats de la recherche en bibliothèque et de la génération de formules pour le premier spectre 
de pic

6 Fermer le fichier de données. a Cliquez sur File > Close Data File.
b Cliquez sur Close.

Tâche 17. Enregistrement des résultats

Étape Instructions détaillées Remarques
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Tâche 17. Enregistrement des résultats
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Guide de familiarisation
3
Utilisation des flux de travaux, 
exportation et impression

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative 
à l'aide du flux de travaux général 78

Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de 
travaux GC/Q-TOF Compound Screening 83

Tâche 20. Exportation d'un fichier CEF 87

Tâche 21. Impression d'un rapport d'analyse 89

Tâche 22. Impression d'un rapport de composé 92

Au cours de ces tâches, vous allez apprendre comment configurer et exécuter 
une méthode d'analyse qualitative. Ensuite, vous allez exécuter les actions de 
la méthode automatisée en ouvrant un fichier de données. 

Deux flux de travaux différents sont utilisés pour ces exemples. Pour plus 
d'informations, reportez-vous à la section « Flux de travaux », page 105.

Le flux de travaux général (General) prend en charge les données CPG/QQQ, 
CPG/Q-TOF et CPL/SM. Le flux de travaux de criblage des composés 
CPG/Q-TOF (GC/Q-TOF Compound Screening) prend en charge des données 
CPG/Q-TOF.

Chaque exercice est présenté dans un tableau à trois colonnes:

• Étapes: utilisez ces instructions générales afin d'explorer le programme par 
vous-même.

• Instructions détaillées: utilisez-les si vous avez besoin d'aide ou si vous 
préférez suivre une méthode d'apprentissage pas à pas.

• Remarques: lisez-les pour obtenir des astuces et des informations 
supplémentaires sur chaque étape de l'exercice.
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Tâche 18. Configuration et exécution d'une méthode d'analyse 
qualitative à l'aide du flux de travaux général

Lorsque vous commencez à utiliser le programme Analyse qualitative pour la 
première fois, la méthode default.m est chargée. Vous pouvez apporter des 
modifications à la méthode ouverte et la sauvegarder, ou ouvrir une nouvelle 
méthode, faire des changements et enregistrer la méthode. Vous ne pouvez pas 
écraser la méthode default.m.

Vous pouvez également configurer l'exécution d'actions spécifiques dans la 
méthode lorsque vous ouvrez un fichier de données. Lorsque vous ouvrez un 
fichier de données, vous pouvez également charger la méthode qui a été 
utilisée pour créer les résultats stockés avec le fichier. La méthode est 
enregistrée automatiquement chaque fois que vous sauvegardez les résultats 
avec le fichier de données. Le flux de travaux général peut être utilisé avec des 
fichiers de données CPG/SM ou CPL/SM.

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux général

Étapes Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données Pest - STD 200 MRM.d.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données Pest - 
STD 200 MRM.d dans le dossier du 
fichier d'exemples de données GC.

c Désélectionnez la case Load result 
data et cliquez sur Open.

• Utilisez ce même flux de travaux ou 
celui de criblage des composés 
CPG/Q-TOF pour travailler avec des 
données CPG/SM.

2 Configurer l'interface utilisateur 
pour travailler avec des données 
CPG.

• Suivez les instructions de la « Tâche 2. 
Configuration de l'interface utilisateur 
pour des données CPG/SM », page 13.

• Pour cet exemple, sélectionnez le 
flux de travaux général.

3 Configurer la méthode pour 
extraire un chromatogramme CIT. 
• Définir un chromatogramme CIT 

pour des données SM.

a Dans la fenêtre Method Explorer, 
sélectionnez Chromatogram > Define 
Chromatograms.

b Supprimez le chromatogramme BPC.
c Sélectionnez TIC comme Type.
d Assurez-vous que la valeur de MS 

Level est MS/MS.
e Cliquez sur Add.
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Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux

général
4 Éditer la méthode pour intégrer les 
données.
• Limiter l'intégration aux quatre 

pics les plus élevés.

a Dans la fenêtre Method Explorer, 
cliquez sur Chromatogram > 
Integrate (MS/MS).

b Cliquez sur l'onglet Peak Filters.
c Dans la section Maximum number of 

peaks, cochez la case Limit (by 
height) to the largest.

d Tapez 4. 

• La mise à jour d'une valeur dans 
l'onglet Peak Filters de la section 
Chromatogram > Integrate (MS) 
actualise également les valeurs des 
autres sections de la fenêtre 
Method Explorer. Des triangles 
bleus apparaissent pour montrer 
ces autres sections.

Figure 46 Chromatogram > Integrate (MS/MS) > onglet Peak Filters

5 Tester l'intégration pour s'assurer 
que seuls 4pics intégrés 
apparaissent.

• Cliquez sur l'icône Integrate 
Chromatogram  pour intégrer le 
fichier de données. 

6 Enregistrer la méthode dans 
iii_GCexercise1, où iii correspond à 
vos initiales.

a Dans le menu principal, cliquez sur 
Method > Save As.

b Tapez iii_GCexercise1.
c Cliquez sur le bouton Save.

• Notez que l'enregistrement de la 
méthode entraîne la disparition de 
tous les triangles bleus indiquant 
des changements de valeur dans la 
méthode ouverte.

7 Changer le fond du spectre de pic 
afin d'utiliser le spectre au début 
d'un pic.

a Dans la fenêtre Method Explorer, 
cliquez sur Spectrum > Extract 
(MS/MS).

b Cliquez sur Peak Spectrum Extraction 
(MS/MS).

c Pour Peak spectrum background, 
sélectionnez l'option Spectrum at 
peak start.

• Si vous effectuez des modifications 
supplémentaires après 
l'enregistrement de la méthode, des 
triangles bleus sont ajoutés.

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux général

Étapes Instructions détaillées Remarques

Vous pouvez cliquer sur 
l'icône Save Method pour 
enregistrer la méthode en 
cours.
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Figure 47 Spectrum > Extract (MS/MS) > onglet Peak Spectrum Extraction (MS/MS)

8 Tester l'extraction de spectre SM 
pour s'assurer qu'un spectre de 
fond est soustrait.

• Cliquez sur l'icône Extract Peak 
Spectrum  pour exécuter l'action 
sur le pic sélectionné dans le fichier de 
données. 

9 Enregistrer la méthode. • Enregistrez la méthode à l'aide de l'une 
des trois méthodes suivantes:
• Cliquez sur l'icône Save 

Method dans Method Editor .
• Cliquez avec le bouton droit 

de la souris dans la fenêtre Method 
Editor, puis sélectionnez Save 
Method.

• Dans le menu principal, cliquez sur 
Method > Save.

• L'icône Save Method est illustrée 
dans la Figure 47, page 80.

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux général

Étapes Instructions détaillées Remarques

Vous pouvez cliquer sur 
l'icône Save Method pour 
enregistrer la méthode en 
cours.
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10 Configurer la méthode pour 
automatiser les actions dont vous 
venez juste de modifier les 
paramètres lorsque vous ouvrez un 
fichier de données.
• Énumérer les actions à effectuer 

lorsque ce fichier de données ou 
un autre est ouvert.

Astuce: rechercher sous General dans 
Method Explorer.

a Dans la fenêtre Method Explorer, 
sélectionnez General > File Open 
Actions.

b Sélectionnez Integrate and Extract 
Peak Spectra dans la liste Available 
actions. 

c Cliquez sur le bouton Add  pour 
déplacer l'action sélectionnée dans la 
liste Actions to be run. 
Vous pouvez également double-cliquer 
sur l'action sélectionnée pour la 
déplacer dans l'autre liste.

11 Tester File Open Actions. • Cliquez sur l'icône Run File Open 
Actions Now  pour exécuter les 
actions sur le fichier de données. 

• Les chromatogrammes et les 
spectres ne sont pas écrasés. De 
nouveaux chromatogrammes et 
spectres sont ajoutés.

Figure 48 Section General > File Open Actions dans Method Editor

12 Enregistrer la méthode. • Cliquez sur l'icône Save Method dans 
la fenêtre Method Editor.

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux général

Étapes Instructions détaillées Remarques

Deux actions différentes font 
partie de la liste Actions to be run. 
La première action consiste à 
extraire les chromatogrammes 
définis. Ensuite, le 
chromatogramme est intégré et 
les pics sont extraits.
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13 Configurer la méthode pour 
automatiser les actions lorsque la 
méthode est exécutée au cours 
d'une liste de tâches.
• Énumérer les actions à effectuer 

lorsque ce fichier de données ou 
un autre est ouvert.

Astuce: rechercher sous Worklist 
Automation dans la fenêtre Method 
Explorer.

a Dans la fenêtre Method Explorer, 
sélectionnez Worklist Automation > 
Worklist Actions.

b Supprimez Generate Analysis Report 
de la liste Actions to be run.

14 Tester Worklist Actions. • Cliquez sur l'icône Run Worklist 
Actions Now  pour exécuter les 
actions sur le fichier de données. 

• Les chromatogrammes et les 
spectres ne sont pas écrasés. De 
nouveaux chromatogrammes et 
spectres sont ajoutés.

Figure 49 Worklist Automation > section Worklist Actions dans la fenêtre Method Editor

15 Enregistrer la méthode et fermer le 
fichier de données sans 
sauvegarder les résultats.

a Cliquez sur l'icône Save Method dans 
la fenêtre Method Editor.

b Cliquez sur File > Close Data File, puis 
sur No lorsque le système vous invite 
à enregistrer les résultats.

Tâche 18. Configuration et exécution d'une méthode d'analyse qualitative à l'aide du flux de travaux général

Étapes Instructions détaillées Remarques

Deux listes d'actions différentes 
sont incluses dans une méthode. 
La première liste d'actions (File 
Open Actions) peut être exécutée 
lorsqu'un fichier de données est 
ouvert. La deuxième liste 
d'actions (Worklist Actions) est 
exécutée lors de l'exécution de la 
méthode.
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Tâche 19. Configuration et exécution d'une méthode à l'aide du flux 
de travaux GC/Q-TOF Compound Screening

Au cours de cette tâche, vous allez configurer une méthode d'analyse qualitative 
qui contient une liste d'actions d'analyse à exécuter dans un ordre spécifique. 
Elles incluent l'extraction et l'intégration de chromatogrammes, l'extraction de 
spectre, la recherche en bibliothèque de spectres de pic, la génération de 
formules pour des spectres et l'impression d'un rapport d'analyse.

Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound Screening

Étapes Instructions détaillées Remarques

1 Ouvrir le CIT pour le fichier de 
données 
MSD_mix_4stds_DG_spl200_03.d
.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data et cliquez sur Open.

2 Configurer l'interface utilisateur 
pour travailler avec des données 
CPG.

• Suivez les instructions de la « Tâche 2. 
Configuration de l'interface utilisateur 
pour des données CPG/SM », page 13.

• Pour cet exemple, sélectionnez le 
flux de travaux GC/Q-TOF 
Compound Screening.

3 S'assurer qu'un CIT est extrait. a Dans la fenêtre Method Explorer, 
sélectionnez Chromatogram.

b Cliquez dans la section Define 
Chromatograms.

c Dans la fenêtre Method Editor, vérifiez 
que le chromatogramme de la section 
Defined chromatograms est un CIT. Si 
ce n'est pas le cas, sélectionnez TIC 
comme Type. Cliquez sur le bouton 
Change.

•
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4 Réviser les paramètres de 
l'algorithme Find by Chromatogram 
Deconvolution.

a Cliquez sur GC/Q-TOF Compound 
Screening > Find by Chromatogram 
Deconvolution dans la fenêtre Method 
Explorer.

b Cliquez sur l'onglet Mass Filter.
c Définissez la valeur de Absolute 

height à 13000.
d Cliquez sur l'onglet Results.
e Cliquez sur le bouton Highlight all 

compounds.
f Révisez les résultats dans chaque 

onglet.

• Examinez les sections du flux de 
travaux GC/Q-TOF Compound 
Screening.

• Notez les six sections du flux de 
travaux. Toutes ces sections sont 
des doubles de sections faisant déjà 
partie de l'explorateur de méthode.

• Notez que des triangles bleus 
apparaissent dans d'autres sections 
de la fenêtre Method Explorer. Ils 
indiquent que les mêmes valeurs de 
paramètre ont été modifiées ailleurs 
également.

5 Réviser les paramètres de 
l'algorithme Identify by Library 
Search.

a Cliquez sur GC/Q-TOF Compound 
Screening > Identify by Library 
Search dans la fenêtre Method 
Explorer.

b Cliquez sur le bouton Add Library. 
Sélectionnez une bibliothèque et 
cliquez sur Open.

c (facultatif) Cliquez sur le bouton 
Remove Library pour supprimer une 
bibliothèque si vous ne souhaitez pas 
l'utiliser.

d Révisez les paramètres dans chaque 
onglet.

• La bibliothèque demo.l ou NIST08.l 
(ou une autre version de la 
bibliothèque NIST) est installée 
dans le dossier 
\MassHunter\Library.

6 Enregistrer la méthode dans 
iii_GCexercise2, où iii correspond à 
vos initiales.

a Dans le menu principal, cliquez sur 
Method > Save As.

b Tapez iii_GCexercise2.
c Cliquez sur le bouton Save.

Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound Screening

Étapes Instructions détaillées Remarques
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Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound

Screening
7 Configurer la méthode pour 
automatiser les actions lorsqu'un 
fichier de données est ouvert.
• Énumérer les actions à effectuer 

lorsque ce fichier de données ou 
un autre est ouvert.

Astuce: rechercher sous General dans 
la fenêtre Method Explorer.

a Dans la fenêtre Method Explorer, 
sélectionnez General > File Open 
Actions.

b Supprimez Generate Analysis Report 
de la liste Actions to be run.

c Supprimez Integrate and Extract Peak 
Spectra.

d Supprimez toutes les autres actions de 
la liste.

e Ajoutez Extract Defined 
Chromatograms.

f Ajoutez Find Compounds by 
Chromatographic Deconvolution.

g Ajoutez Search Spectral Library for 
Compound.

8 Tester File Open Actions. • Cliquez sur l'icône Run 'File Open' 
Actions Now  pour exécuter les 
actions sur le fichier de données. 

• Les chromatogrammes et les 
spectres ne sont pas écrasés. De 
nouveaux chromatogrammes et 
spectres sont ajoutés.

Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound Screening

Étapes Instructions détaillées Remarques
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Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound 
Screening
Figure 50 Résultats de l'exécution des actions de la liste de tâches sur les données CPG/Q-TOF

9 Enregistrer la méthode dans 
iii_GCexercise2, où iii correspond à 
vos initiales.

a Dans le menu, cliquez sur Method > 
Save As.

b Tapez iii_GCexercise2.
c Cliquez sur Save.

• Si la méthode est exécutée pendant 
une liste de tâches d'acquisition de 
données, les actions de la liste de 
tâches de cet onglet sont exécutées 
dans l'ordre indiqué.

10 Fermer le fichier de données sans 
enregistrer les résultats.

a Cliquez sur File > Close Data File.
b Cliquez sur No lorsque le système 

vous invite à enregistrer les résultats.

Tâche 19. Configuration et exécution d'une méthode à l'aide du flux de travaux GC/Q-TOF Compound Screening

Étapes Instructions détaillées Remarques
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Tâche 20. Exportation d'un fichier CEF
Tâche 20. Exportation d'un fichier CEF

Vous pouvez exporter un fichier CEF contenant des informations sur les 
composés. Ce fichier CEF peut être importé dans d'autres programmes, tels 
que MassHunter Quantitative Analysis et Mass Profiler Professional. Vous 
pouvez également importer des composés qui ont été exportés dans un fichier 
CEF.

Tâche 20. Exportation d'un fichier CEF

Étapes Instructions détaillées Remarques

1 Ouvrir le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
et exécuter les actions File Open 
pour la méthode iii_GCexercise2.m 
créée au cours de la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data.

d Cochez la case Run ‘File Open’ 
actions from selected method.

e Cliquez sur le bouton Use current 
method et cliquez sur Open.

• Si vous avez terminé la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83, la méthode actuelle est 
iii_GCexercise2.m. Cette méthode 
est configurée pour exécuter 
l'algorithme Find Compounds by 
Chromatogram Deconvolution, puis 
l'algorithme Search Library sur 
chaque composé.

2 Exporter un fichier CEF. a Pour exporter de manière interactive le 
fichier, cliquez sur File > Export > as 
CEF.

b Cliquez sur le bouton All results.
c Sélectionnez l'emplacement du fichier 

d'exportation.
d Cliquez sur OK.

• Un fichier CEF est utilisé pour 
exporter des composés. 
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Tâche 20. Exportation d'un fichier CEF
Figure 51 Boîte de dialogue Export CEF Options

Tâche 20. Exportation d'un fichier CEF (suite)

Étapes Instructions détaillées Remarques
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Tâche 21. Impression d'un rapport d'analyse
Tâche 21. Impression d'un rapport d'analyse

Chaque fois que vous voulez imprimer un rapport d'analyse après l'exécution 
de l'une des tâches de cet exercice ou du suivant, utilisez ces instructions. 

Un rapport d'analyse peut contenir les résultats de l'extraction et de 
l'intégration de chromatogrammes, de l'extraction de spectres, de la détection 
de composés, des recherches de spectres de pic dans la base de données ou de 
la génération de formules à partir de spectres de pic. 

Tâche 21. Impression d'un rapport d'analyse

Étapes Instructions détaillées Remarques

1 Si le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
n'est pas déjà chargé, l'ouvrir et 
exécuter les actions File Open pour 
la méthode iii_GCexercise2.m 
créée au cours de la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data.

d Cochez la case Run ‘File Open’ 
actions from selected method.

e Cliquez sur le bouton Use current 
method et cliquez sur Open.

• Si vous avez terminé la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83, la méthode actuelle est 
iii_GCexercise2.m. Cette méthode 
est configurée pour exécuter 
l'algorithme Find Compounds by 
Chromatogram Deconvolution, puis 
l'algorithme Search Library sur 
chaque composé.

2 Changer les sélections du rapport 
d'analyse dans la méthode:
• Cocher les cases des 

chromatogrammes, spectres ou 
tableaux à imprimer.

• Désélectionner les cases des 
chromatogrammes, spectres ou 
tableaux à ne pas imprimer.

a Dans la fenêtre Method Explorer, 
cliquez sur Reports > Analysis Report.

b Cochez les cases des sélections 
supplémentaires à imprimer.

c Désélectionnez les cases des 
chromatogrammes et spectres que 
vous ne souhaitez pas imprimer.

• Le rapport d'analyse contient 
uniquement les informations que 
vous avez sélectionnées dans cette 
section. 

• Si certains résultats ne sont pas 
disponibles, ils ne sont pas inclus, 
même s'ils sont sélectionnés dans 
cette section. Par exemple, si vous 
n'avez pas intégré le 
chromatogramme, le tableau des 
pics n'est pas inclus.
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Tâche 21. Impression d'un rapport d'analyse
Figure 52 Section Analysis Report dans les fenêtres Method Explorer et Method Editor

3 Imprimer le rapport. a Vous pouvez imprimer le rapport de 
manière interactive de plusieurs 
façons:
• Dans le menu principal, cliquez sur 

File > Print > Analysis Report.
• Dans la barre d'outils principale, 

cliquez sur l'icône Printer.
• Cliquez sur l'icône Print Analysis 

Report  dans la barre d'outils 
Method Editor lorsque la section 
Analysis Report est sélectionnée.

• Cliquez avec le bouton droit de la 
section Analysis Report dans 
Method Editor, puis cliquez sur Print 
Analysis Report.

• Dans le menu contextuel du fichier 
de données dans Data Navigator, 
cliquez sur Analysis Report.

b Cliquez sur Report contents.
c Cochez la case Print report et 

sélectionnez une imprimante.
d Cochez la case Print preview.
e Cliquez sur le bouton OK.

• L'icône Run  de la barre 
d'outils Method Editor vous permet 
parfois de choisir une action parmi 
plusieurs actions possibles. Par 
exemple, si vous basculez sur la 
section Reports > Common 
Reporting Options de la fenêtre 
Method Editor, quatre actions 
différentes sont possibles lorsque 
vous cliquez sur l'icône Run. Si vous 
cliquez sur la flèche, une liste 
d'actions possibles s'affiche et 
vous pouvez choisir l'action à 
exécuter. Le fait de choisir une autre 
action dans la liste change l'action 
par défaut. Si vous cliquez 
simplement sur le bouton Run, 
l'action courante par défaut est 
effectuée.

Tâche 21. Impression d'un rapport d'analyse (suite)

Étapes Instructions détaillées Remarques

Par défaut, la fenêtre Method Editor 
est flottante. Elle est visible comme 
une fenêtre distincte du reste du 
programme d'analyse qualitative. 
Pour ancrer la fenêtre, cliquez avec le 
bouton droit de la souris sur le titre de 
la fenêtre, puis cliquez sur Floating. 
Vous pouvez également cliquer sur la 
barre de titre pour ancrer la fenêtre.
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Tâche 21. Impression d'un rapport d'analyse
Figure 53 Boîte de dialogue Print Analysis Report

f Révisez le rapport.
g Cliquez sur l'icône Close Print 

Preview dans la barre d'outils.

Figure 54 Fenêtre Print Preview avec rapport d'analyse

Tâche 21. Impression d'un rapport d'analyse (suite)

Étapes Instructions détaillées Remarques
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Tâche 22. Impression d'un rapport de composé
Tâche 22. Impression d'un rapport de composé

Chaque fois que vous voulez imprimer un rapport de composé, suivez ces 
instructions.

Tâche 22. Impression d'un rapport de composé

Étape Instructions détaillées Remarques

1 Si le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
n'est pas déjà chargé, l'ouvrir et 
exécuter les actions File Open pour 
la méthode iii_GCexercise2.m 
créée au cours de la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83.

a Si le programme n'est pas déjà ouvert, 
double-cliquez sur l'icône MassHunter 
Qualitative Analysis. Sinon, cliquez 
sur File > Open Data File.

b Cliquez sur le fichier de données 
MSD_mix_4stds_DG_spl200_03.d 
dans le dossier de fichiers d'exemples 
de données CPG.

c Désélectionnez la case Load result 
data.

d Cochez la case Run ‘File Open’ 
actions from selected method.

e Cliquez sur le bouton Use current 
method et cliquez sur Open.

• Si vous avez terminé la « Tâche 19. 
Configuration et exécution d'une 
méthode à l'aide du flux de travaux 
GC/Q-TOF Compound Screening », 
page 83, la méthode actuelle est 
iii_GCexercise2.m. Cette méthode 
est configurée pour exécuter 
l'algorithme Find Compounds by 
Chromatogram Deconvolution, puis 
l'algorithme Search Library sur 
chaque composé.

2 Changer des sélections dans la 
méthode des rapports de composé:
• Désactiver l'affichage des 

spectres SM dans lesquels des 
pics spéciaux sont zoomés.

• Désactiver les options SM/SM 
dans le rapport.

a Dans la fenêtre Method Explorer, 
cliquez sur Reports > Compound 
Report.

b Désélectionnez la case Show MS 
spectrum.

c Désélectionnez la case Show MS/MS 
spectrum.

d Désélectionnez la case Show MS/MS 
peak table.

• Ces cases à cocher permettent de 
spécifier les informations à inclure 
dans un rapport si elles sont 
disponibles. En revanche, si elles ne 
le sont pas, la section est 
automatiquement ignorée. Par 
exemple, les résultats SM/SM ne 
sont jamais inclus si le fichier de 
données est uniquement SM.
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Tâche 22. Impression d'un rapport de composé
Figure 55 Section Compound Report de la fenêtre Method Editor

3 (facultatif) Choisir un autre modèle 
de rapport de composé.

a Dans la fenêtre Method Explorer, 
cliquez sur Reports > Common 
Reporting Options.

b Sélectionnez le fichier 
CompoundReport
WithIdentificationHits.xlsx comme 
modèle de rapport de composé.

• Plusieurs modèles de rapport 
différents sont inclus dans le 
logiciel.

• Vous pouvez personnaliser un 
modèle de rapport à l'aide d'Excel et 
de l'extension Report Designer.

Figure 56 Section Common Reporting Options de la fenêtre Method Editor

Tâche 22. Impression d'un rapport de composé

Étape Instructions détaillées Remarques

La case Overlay compound 
chromatograms doit être 
désélectionnée pour les données 
CPG/Q-TOF.

Vous pouvez utilise Excel et 
l'extension Report Designer pour 
personnaliser l'un des modèles 
ayant l'extension XLTX. Vous ne 
pouvez pas personnaliser le 
rapport de la méthode 
d'acquisition.
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Tâche 22. Impression d'un rapport de composé
4 Imprimer le rapport. a Cliquez sur File > Print > Compound 
Report ou cliquez sur la flèche de 
l'icône Print Analysis Report  et 
cliquez sur Print Compound Report 
pour imprimer le rapport de composé.

b Cochez la case Print preview.
c Cliquez sur OK. Examinez le rapport.
d Cliquez sur l'icône Close Print 

Preview.

• Dans la boîte de dialogue Print 
Compound Report, vous pouvez 
sélectionner une autre imprimante, 
choisir d'enregistrer un fichier PDF 
ou Excel, d'imprimer tous les 
résultats ou seulement les résultats 
sélectionnés, et de combiner ou non 
différents fichiers de données dans 
un rapport.

• Pour plus d'informations, consultez 
l'aide en ligne ou le DVD Report 
Designer Training.

Figure 57 Fenêtre Print Preview avec rapport de composé

5 Fermer le fichier de données sans 
enregistrer les résultats.

a Cliquez sur File > Close Data File.
b Cliquez sur No lorsque le système 

vous demande si vous souhaitez 
enregistrer les résultats.

Tâche 22. Impression d'un rapport de composé

Étape Instructions détaillées Remarques
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Utilisation des fenêtres
Utilisation des fenêtres

Lorsque vous ouvrez pour la première fois le programme Analyse qualitative, vous 
pouvez voir quatre fenêtre dans la présentation par défaut: Data Navigator, 
Method Explorer, Chromatogram Results et MS Spectrum Results. Vous pouvez 
basculer entre les fenêtres Navigator View et Compound Details View.

Vous pouvez afficher 17autres fenêtres dans Navigator View à l'aide du menu 
View: 

• Method Editor permet d'éditer les paramètres de méthode séparés dans 
différents onglets

• Spectrum Preview permet de balayer rapidement les spectres dans un 
fichier de données

• MS Spectrum Results affiche les spectres SM et SM/SM

• Difference Results présente les différents résultats après une recherche en 
bibliothèque

• Deconvolution Results présente les spectres déconvolués

• Deconvolution Mirror Plot présente deux spectres déconvolués dans une 
image en miroir

• UV Spectrum Results présente les spectres UV, disponibles uniquement 
pour les données CPL/SM

• Integration Peak List affiche les résultats d'intégration dans un tableau

• MS Spectrum Peak List 1 présente le tableau des pics pour le premier 
spectre sélectionné

• MS Spectrum Peak List 2 présente le tableau des pics pour le deuxième 
spectre sélectionné

• MS Actuals affiche les informations d'acquisition pour le spectre mis en 
surbrillance

• Compound List présente les composés détectés à l'aide de l'un des 
algorithmes Find Compounds

• Compound Identification Results présente les informations d'identification 
du composé sélectionné

• Spectrum Identification Results présente les informations d'identification 
du spectre sélectionné

• MS/MS Formula Details affiche un tableau contenant les formules possibles 
calculées pour les fragments vus dans un spectre SM/SM
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• Structure Viewer présente la structure associée au composé ou aux spectres 
courants

• Sample Information présente des informations sur le fichier de données 
mis en surbrillance

• Sequence Editor permet d'éditer une séquence de méthode

Vous pouvez également afficher trois fenêtres d'outils qui s'ouvrent lorsque 
vous commencez à utiliser l'outil associé:

• Formula Calculator

• Mass Calculator

• Recalibrate

Icônes des fenêtres dans la barre d'outils principale

Les icônes de la barre d'outils principale permettent d'ouvrir et de fermer les 
fenêtres. Des icônes supplémentaires sont disponibles lorsque le logiciel 
MassHunter BioConfirm est installé. Les options du menu View peuvent être 
également utilisées pour ouvrir ces fenêtres.
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Utilisation des données de résultats dans Data Navigator

Fenêtre et outils du navigateur de données (Data Navigator)

Data Navigator organise tous les résultats d'extraction et de sélection de spectre 
par fichier de données ou par type de données.

 

Lorsqu'elle est activée (par défaut), la sélection 
d'un chromatogramme dans Data Navigator met 
également en surbrillance les spectres 
correspondants. Les résultats graphiques du 
chromatogramme et du spectre correspondants 
sont également mis en surbrillance. Linked 
Navigation ne fonctionne que si vous avez utilisé 
l'option Integrate and Extract Peak Spectra du 
menu Chromatograms ou si vous avez exécuté 
l'un des algorithmes Compounds.

Coche simple coche les cases de toutes les 
données en surbrillance.

Coche double, dont une grise coche les cases de 
toutes les données en surbrillance et supprime les 
coches des autres cases.

Coche double coche toutes les cases.

Les chromatogrammes et les spectres s'affichent 
lorsque leurs case sont cochées.

Outils permettant de cocher

Icône Linked Navigation
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Exécution d'opérations sur le chromatogramme

Vous pouvez exécuter les opérations suivantes sur la totalité ou sur une zone 
sélectionnée du chromatogramme à l'aide des options de menu suivantes:

Action Option de menu

Changer les libellés des pics dans le 
chromatogramme

Configuration > Chromatogram Display Options

Extraire un chromatogramme Chromatograms > Extract Chromatograms

Extraire les chromatogrammes définis Chromatograms > Extract Defined Chromatograms

Intégrer le chromatogramme Chromatograms > Integrate Chromatogram

Intégrer et extraire des spectres de pic Chromatograms > Integrate and Extract Peak Spectra

Intégrer et déconvoluer des spectres de pic Chromatograms > Integrate and Deconvolute Peak 
Spectra

Lisser le chromatogramme Chromatograms > Smooth Chromatogram

Soustraire un chromatogramme Chromatograms > Subtract Any Chromatogram

Calculer le rapport signal/bruit Chromatograms > Calculate Signal-to-Noise

Détecter des composés à partir de données 
auto SM/SM

Find > Find Compounds by Auto MS/MS

Détecter des composés à partir de données 
ciblées SM/SM

Find > Find Compounds by Targeted MS/MS

Détecter des composés à partir de données 
SM(1)

Find > Find Compounds by Molecular Feature

Détecter des composés à partir de données 
CPG/SM

Find > Find Compounds by Chromatogram 
Deconvolution

Détecter des composés pour des données 
MRM

Find > Find Compounds by MRM

Détecter des composés par les résultats 
d'intégration

Find > Find Compounds by Integration

Détecter des composés qui correspondent 
à des formules spécifiques

Find > Find Compounds by Formula
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Sélectionner des opérations de la gamme à partir d'un menu contextuel

Si vous avez sélectionné une gamme chromatographique, vous pouvez également 
extraire un spectre de fond, en plus des opérations mentionnées ci-dessus et des 
autres qui ne le sont pas.

1 Pour accéder à ces opérations, cliquez sur l'outil Range Select  dans la barre 
d'outils Chromatogram Results. 

2 Cliquez sur le point auquel vous souhaitez démarrer la gamme, faites glisser le 
pointeur sur une plage et relâchez le bouton de la souris.

3 Cliquez avec le bouton droit de la souris n'importe où dans le chromatogramme 
et sélectionnez l'opération dans le menu contextuel qui s'affiche.

Enregistrer les résultats dans le(s) fichier(s) de données

• Cliquez sur l'icône Save  ou sélectionnez File > Save Results.

Lorsque vous quittez le programme, il vous demande également si vous voulez 
enregistrer les résultats dans le fichier de données, à moins que vous n'ayez 
désactivé cette option dans la boîte de dialogue Message Box Options.

Exécution d'opérations sur un spectre SM ou SM/SM

Vous pouvez effectuer les opérations suivantes sur un spectre SM ou SM/SM ou sur 
une zone sélectionnée d'un spectre SM ou SM/SM à l'aide des options de menu 
suivantes:

Action Option de menu

Afficher le rapport m/z, l'abondance, l'état 
de charge et d'autres informations sur les 
pics d'un spectre

View > MS Spectrum Peak List 1

Changer les libellés d'un pic spectral Configuration > MS and MS/MS Spectra Display 
Options

Soustraire le spectre de fond Spectra > Subtract Background Spectrum

Soustraire un spectre Spectra > Subtract Any Spectrum (puis cliquer sur un 
autre spectre)

Ajouter deux spectres à la fois Spectra > Add Any Spectrum (puis cliquer sur un 
autre spectre)
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Utilisation de données chromatographiques visuelles

Fenêtre Chromatogram Results

Rechercher dans une base de données des 
entrées qui correspondent à des masses 
spécifiques d'un spectre

Spectra > Search Database for Spectrum Peaks

Générer des formules pour les masses 
dans la gamme sélectionnée d'un spectre 

Spectra > Generate Formulas from Spectrum Peaks 
(lorsqu'une gamme est sélectionnée dans le spectre 
SM)

Déconvoluer à l'aide de l'algorithme 
Resolved Isotope

Spectra > Deconvolute (Resolved Isotope)

Rechercher en bibliothèque Identify > Search Library for Spectra ou
Spectra > Search Library for Spectra

Action Option de menu
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Outils Chromatogram Results

Outils de zoom 
dans l'ordre

Outils de sélection dans l'ordre
Range Select: lorsque cet outil est activé, vous pouvez 
dessiner une plage sur un chromatogramme, dans laquelle 
vous pouvez effectuer des actions.

Peak Select: lorsque cet outil est activé, vous pouvez 
sélectionner le spectre d'un pic intégré à son sommet.

Manual Integration: lorsque cet outil est activé, vous 
pouvez intégrer de manière interactive.

Walk Chromatogram: lorsque cet outil est activé, vous 
pouvez voir des spectres individuels lorsque vous cliquez 
sur chaque point ou utilisez les flèches droite et gauche 
sur le clavier.

Annotation: lorsque cet outil est activé, vous pouvez 
ajouter des annotations image et texte aux 
chromatogrammes.

Échelle automatique des axes X et Y

Échelle automatique de l'axe X

Échelle automatique de l'axe Y

Annuler le zoom

Échelle automatique de l'axe Y pendant un zoom

Mode axe Y lié

L'un de ces outils doit 
toujours être sélectionné.
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Utilisation de données spectrales visuelles

Fenêtre MS Spectrum Results

Outils MS Spectrum Results

Outils de zoom 
dans l'ordre

Outils de sélection 
dans l'ordre

Range Select: lorsque cet outil est activé, vous pouvez dessiner 
une plage sur un chromatogramme, dans laquelle vous pouvez 
effectuer des actions.

Annotation: lorsque cet outil est activé, vous pouvez ajouter des 
annotations image et texte aux chromatogrammes.

Calipers: lorsque cet outil est activé, vous pouvez ajouter un 
compas d'épaisseur sur le spectre sélectionné. Dans la fenêtre 
Deconvolution Results, vous pouvez également ajouter un 
dispositif pour les acides aminés (Amino Acid caliper) ou pour les 
modifications. Pour plus d'informations, consultez l'aide en ligne.

Échelle automatique des axes X et Y

Échelle automatique de l'axe X

Échelle automatique de l'axe Y

Annuler le zoom

Échelle automatique de l'axe Y pendant un zoom

Mode axe Y lié

Pour annuler la 
sélection d'un outil, 
cliquez sur un autre 
outil ou une autre 
icône.
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Flux de travaux

Les flux de travaux permettent de personnaliser l'interface utilisateur pour 
votre application. Chaque flux de travaux charge une méthode différente dont 
les paramètres lui sont appropriés. De plus, chaque flux de travaux charge une 
présentation différente. Les présentations incluent la personnalisation des 
colonnes affichées dans chacun des tableaux. Enfin, quatre des présentations 
ajoutent également une section réservée à un éditeur de méthode qui contient 
des copies des sections de l'éditeur de méthode ayant de l'importance pour le 
flux de travaux. Le regroupement des fonctions utilisées dans un flux de 
travaux spécifique facilite la personnalisation de votre méthode.

Le programme d'analyse qualitative comporte les différents flux de travaux 
suivants:

• General

• BioConfirm - Ces flux de travaux sont disponibles uniquement si le logiciel 
BioConfirm est installé et coché dans la boîte de dialogue User Interface 
Configuration. BioConfirm propose plusieurs flux de travaux possibles, 
selon le type d'analyse à réaliser. BioConfirm est utilisé avec des fichiers de 
données CPL/SM.

• Chromatogram Peak Survey

• Formula Confirmation and Sample Purity

• MS Target Compound Screening

• GC/Q-TOF Compound Screening

Si vous utilisez des donnés CPG/SM, vous pouvez sélectionner le flux de 
travaux General ou le flux de travaux GC/Q-TOF Compound Screening. Si vous 
utilisez des donnés CPL/SM, vous pouvez sélectionner l'un des flux de travaux, 
excepté GC/Q-TOF Compound Screening.

Méthode particulière

Chaque flux de travaux charge une méthode par défaut particulière avec des 
paramètres qui lui sont appropriés. Par exemple, si vous basculez sur l'un des 
flux de travaux BioConfirm, le type de données cibles pour l'algorithme Find 
Compounds by Molecular Feature est défini à Large molecules (proteins, 
oligos). Ce paramètre est adapté au flux de travaux BioConfirm mais pas par 
défaut pour les autres flux de travaux.
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Présentation particulière

En outre, chaque flux de travaux charge une présentation spécifique qui 
établit les éléments suivants:

• Position et taille de chaque fenêtre

• Fenêtres comportant des onglets

• Fenêtres flottantes

• Désignation de la fenêtre avec onglets figurant sur le dessus

• Fenêtres visibles par défaut

• Indique si la barre d'état est visible

Pour chaque fenêtre de tracé (fenêtres Chromatogram Results, Spectrum 
Preview, MS Spectrum Results, Deconvolution et UV Results), les éléments 
suivants sont enregistrés:

• Si les graphiques se chevauchent ou non

• Si l'option Autoscale Y-Axis est activée ou non pendant le mode Zoom

• Si le mode Linked Y-Axis est activé ou non

Pour chaque fenêtre représentant un tableau, les éléments suivants sont 
enregistrés:

• Quelles colonnes sont visibles

• L'ordre des colonnes

• La largeur de chaque colonne

• Tout filtre ayant été ajouté au tableau (disponible uniquement pour le 
tableau Compound List ou Compound Identification Results et la fenêtre 
Spectrum Identification Results).

Section spécifique aux fenêtres Method Explorer et Method Editor

Si vous utilisez Method Editor avec le flux de travaux General, vous pouvez 
modifier presque tous les paramètres de la méthode. 

Chaque des quatre autres flux de travaux change les sections disponibles dans 
la fenêtre Method Explorer. Chaque nouvelle section contient uniquement les 
onglets et les sections de Method Editor utiles dans ce flux de travaux. Le 
changement d'un paramètre dans le flux de travaux modifie également le 
paramètre de la section correspondante dans les sections générales de Method 
Editor.
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Deux onglets ne sont pas répétés dans les sections générales de Method Editor. 
La section Chromatogram Peak Survey Workflow > Spectrum Peak 
Identification et l'onglet Chromatogram Peak Survey Workflow > 
Chromatogram Extraction > Chromatograms sont inclus uniquement dans le 
flux de travaux Chromatogram Peak Survey. Ces sections affectent 
uniquement l'algorithme Chromatogram Peak Survey. Cet algorithme est 
utilisé uniquement dans ce flux de travaux et dans les actions Chromatogram 
Peak Survey without Report et Chromatogram Peak Survey with Analysis 
Report.

Méthodes et présentations des flux de travaux

Des méthodes et des présentations supplémentaires par défaut sont fournies 
pour chaque flux de travaux. 

Flux de travaux Méthode Présentation Section de l'éditeur de 
méthode

General default.m Default.xml Aucune

BioConfirm Intact 
Protein

BioConfirm
IntactProtein-
Default.m

BioConfirm-
IntactProtein-
MaximumEntropy-
Default.xml

BioConfirm Workflow

BioConfirm High 
Mass Intact Protein

BioConfirm
IntactProtein
HighMass
Default.m

BioConfirm
IntactProtein
LMFE.xml

BioConfirm Workflow

BioConfirm Small 
Oligonucleotides

BioConfirmOligo
nucleotideSmall.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Large 
Oligonucleotides

BioConfirmOligo
nucleotideLarge-
Default.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Protein 
Digest

BioConfirmProtein
Digest-Default.m

BioConfirm
ProteinDigest.xml

BioConfirm Workflow

BioConfirm 
Synthetic Peptide

BioConfirmSynthetic
Peptide-Default.m

BioConfirm
SyntheticPeptide.xml

BioConfirm Workflow

Chromatogram Peak 
Survey

ChromPeakSurvey-
Default.m

Default.xml Chromatogram Peak 
Survey Workflow
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Formula 
Confirmation and 
Sample Purity

SamplePurity-
Default.m

SamplePurity-
Default.xml

Formula Confirmation and 
Sample Purity Workflow

MS Target 
Compound 
Screening

Screening-Default.m Screening-Default.xml MS Target Compound 
Screening Workflow

GC Q-TOF 
Compound 
Screening

GC_Q-TOF.m QTOFData.xml GC/Q-TOF Compound 
Screening

Flux de travaux Méthode Présentation Section de l'éditeur de 
méthode
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Personnalisation d'un modèle de rapport

Consultez l'aide en ligne du module d'extension MassHunter Report Designer, 
le guide de familiarisation de Report Designer ou le DVD de formation sur la 
génération de rapports pour plus de détails sur la modification d'un modèle de 
rapport. Les étapes suivantes vous donnent un aperçu rapide de ce que 
signifie personnaliser un modèle.

1 Accédez au dossier contenant les modèles de rapport. Par défaut, il s'agit du 
dossier: 
\MassHunter\Report Templates\Qual\B.05.00\en-US\Letter. Vous pouvez 
sélectionner un autre dossier dans la fenêtre Method Explorer dans l'onglet 
General > Common Reporting Options > Templates.

2 Faites une copie du modèle que vous avez l'intention de modifier. Cliquez avec 
le bouton droit de la souris sur la copie et sélectionnez Properties. Si 
nécessaire, désélectionnez la case Read-only. Ensuite, cliquez avec le bouton 
droit de la souris sur la copie et cliquez sur Open dans le menu contextuel.

L'ouverture du modèle de cette façon permet à Excel de savoir que ce fichier est 
un fichier modèle. Une fois le modèle ouvert, vous pouvez modifier les en-têtes 
et les pieds de page et ajouter, supprimer ou déplacer des colonnes de 
paramètres. Pour plus d'informations, reportez-vous à l'aide en ligne. Tous les 
modèles du programme Qualitative Analysis sont en lecture seule. Modifiez 
cette propriété avant d'éditer un modèle.
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De nombreux modèles sont installés avec le programme d'analyse 
qualitative. Reportez-vous à l'aide en ligne du programme pour plus 
d'informations sur le contenu de chaque modèle de rapport.

3 effectuez les changements souhaités.

Pour plus d'informations sur la procédure à suivre pour modifier un 
modèle, consultez l'aide en ligne du module d'extension MassHunter Report 
Designer ou le DVD de formation Agilent MassHunter Reporting.

4 Pour enregistrer le nouveau modèle, cliquez sur Save ou sur Save As > Other 
Formats à partir du bouton Microsoft Office. 

5 Saisissez un nom d'identification et cliquez sur Save.
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